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CHAPTER 1 
 
QUICK START 
 
INSTALLATION 
 
 
Step 1 – Install program: 
 
Insert CD-ROM (Disk “A” of any multi-CD subject) in CD drive. | Double-click on My 
Computer | Double-click on your CD drive. | Double-click on Install.exe and follow the on-
screen instructions. 
 
Note:  Detailed installation instructions are found in Chapter 2.  Quick Start instructions 
provide minimal explanations. 
 
Step 2 – Install individual subjects: 
 
To install another subject: 
 

1. Open the Apostolic Bible Curriculum program. (Double-click on the light-switch icon 
on your desktop.) 

2. Click on Go to Teacher Mode. 
3. Click on School Setup. 
4. Click on Install Subject from CD-ROM and follow the on-screen instructions.  Repeat 

for all subjects. 
 
SETUP 
 
Part 1:  School Setup 
 
(Create a teacher Password; create a school calendar.) 
 
Note:  Detailed Setup instructions are found in Chapter 5, Setting up.  Quick Start instructions 
provide minimal explanations. 
 
While you are still in School Setup: 

1. Make up a password and type it in the box labeled “Teacher Password” at the top of the 
screen. 

2. Click on Set Calendar for School; change date if necessary. 
3. Select all days appropriate to your school’s schedule or, choose Load Default 180-Day 

Calendar at the top of the screen; then make changes to the calendar days 
4. Click DONE on the toolbar to save and return to the School Setup menu.  Click DONE 

again to return to the Teacher Menu. 
 
Part 2: Student Setup 
(Add a Student, assign subjects, create a lesson plan.) 

1. Click on Add Student. 
2. Type in student’s name and click OK; program advances to Student Setup. 
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3. Assign each subject by clicking on the appropriate box.  
4. Type a password in the box labeled “Student Password.” 
5. Click on Create Lesson Plan. 
6. Choose either your school calendar (recommended), the default calendar that came with 

the program, or create a unique calendar for the student by clicking on the individual 
days to select them. 

7. Click DONE to save the changes and go back to the Student Setup menu.  When 
prompted to create a lesson plan, click Yes. 

8. Click DONE again to go back to the Teacher Menu.  This student is ready to work. 
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CHAPTER 2 
 
INSTALLATION 
 
INTRODUCTION 
 
Apostolic Bible Curriculum is a powerful educational tool designed to reduce the teacher’s 
administrative load and improve student academics.  Using the Curriculum, you will be able to 
do the same things you did with a paper curriculum-and more!  From designing your own 
projects to skipping lessons or re-arranging units, you can customize the Curriculum to fit your 
needs. 
 
If you are new to the Curriculum, take some time to familiarize yourself with how it works.  
You can set up a practice student and test all the options before setting up your real students.  
Then you can delete your practice student once you are comfortable with the program. 
 
Apostolic Bible Curriculum comes with default settings already in place.  However, you may 
want to adjust some of the settings to customize the program for your particular students and 
for your teaching style. 
 
INSTALLATION* 
 
Home-school users:  You will need to (1) install the program, and (2) install each subject. 
 
Note:  Close all other programs, including screen savers, before installing and running 
Apostolic Bible Curriculum.  This will keep the programs from competing with each other: 
 
Step 1 – Install program: 
 
Insert CD-ROM (Disk “A” of any multi-CD subject) in CD drive | Double-click on My 
Computer | Double-click on the CD drive | Double-click on Install.exe and follow the on-screen 
instructions. 
 
Installation Options:   
 
The installation options “Minimal,””Small,” and “Full” all install Apostolic Bible Curriculum 
(code) to your computer and add that particular subject to the list of available subjects. 
 
“Full” installation is recommended because it contains all the features, including multimedia 
enhancements and games.  Select an installation based on the amount of hard drive space you 
have on your computer.   
 
 
Location on Hard Drive:  Unless you specify otherwise, Apostolic Bible Curriculum will be 
installed to “C:\SOS” (a folder labeled “SOS” on your C:\ drive).  All information pertaining to 
Apostolic Bible Curriculum and your students’ work will go into the SOS folder.  Note:  This 
path is a DOS path, not a Windows path. 
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Important note:  You only need to install the Apostolic Bible Curriculum code ONCE.  This 
sets up the Apostolic Bible Curriculum program.  After that, all subjects and grade levels plug 
in to this one system.  For example, DO NOT install separate grade levels to C:\SOS6 and then 
C:\SOS7 for the 6th grade and then a separate 7th grade. 
 
Step 2 – Install subject from CD-ROM: 
 
Each subject must be added to the program. 
 
To install a subject: 

1. Insert CD-ROM (Disk “A” of any multi-CD subject) in CD drive. 
2. Open the Apostolic Bible Curriculum program (Double-click on the light-switch icon 

on your desktop.) 
3. Click on Go to Teacher Mode. 
4. Click on School Setup. 
5. Click on Install Subject from CD-ROM. 
6. Follow the on-screen instructions. 

 
To uninstall subjects: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup 
3. Click on Uninstall Subjects. 
4. Select the subjects you want to remove.  Click DONE on the toolbar. 

 
Note:  Uninstalling a subject should not be confused with unassigning a subject.  Uninstalling a 
subject takes the subject completely off the system.  Unassigning a subject is equivalent of 
taking a student’s book away for a short time (the student cannot access it until it is reassigned). 
 
Once you have installed the program and all the subjects, you are ready to set up the school and 
your students (see Chapter 5, Setting up). 
 
NETWORK INSTALLATION INSTRUCTIONS 
 
You must have a local area network (LAN) in order to network student data across computers.  
Networking student data will allow teachers and students access to their work from any 
computer in the network. 
 
WARNING! We recommend that you set up the network prior to beginning your school year.  
If you choose to set up the network after the school year has begun, you will have to manually 
transfer current student work and grades to the network.  For technical support, visit our web 
sites at: 

www.aop.com
 

To set up the network: 
 
Step 1 – On the Teacher’s Computer: 
 

1. Do a regular install on the teacher’s computer as per previous instructions, then add all 
the subjects. 

http://www.aop.com/
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2. Enable File and Print Sharing. 
 

WIN95\98 Right-click Network Neighborhood | Choose Properties | Click the button 
labeled FILE AND PRINT SHARING | Mark the box next to “I want to be able to give 
others access to my files” | Click OK | Click OK again to restart your computer. 
 
WINME\Win2000:  Double-click Network Places | Double-click the network Wizard | 
Follow the on-screen instructions to give others access to your files. 
 

3. Share the SOS directory.  (Open the C: drive through My Computer or Windows 
Explorer: Right-click on the folder marked SOS | Go to Properties select the Sharing tab 
| Choose Shared As | Choose Access Type as full.) 

 
Step 2 – On the Networked Student Computers: 
 

1. Map a new drive and link it to the shared directory (folder) on the teacher’s computer: 
 

Double-click on NETWORK NEIGHBORHOOD | Double-click the Teacher’s 
computer icon | Right-click the SOS folder and click on Map Network Drive | Choose a 
drive letter that is not in use, for example: F: | Click OK | F: now points to the SOS 
folder on the teacher computer. 
 

2. Install the student’s computer to the Apostolic Bible Curriculum network: 
 

Insert any subject CD-ROM (the “A” disk of any multi-CD set) into the CD drive on the 
student’s computer and run the install.exe program. From the Install Options select 
“Install Student on Network.”  Replace the line C:\SOS with X:\ (where X is the newly 
mapped drive letter you choose in Step 1.)  Note:  Do not include SOS; X:\ is all that 
should be there.  See picture below: 

 
Note:  You do not need to install subjects onto student computers since students will 
beaccessing the program from the teacher’s computer where you have already installed all the 
subjects. 
 
Note:  You cannot copy the information from the CD-ROMs to a hard drive.  Students must 
have the CD-ROMs when they are working on their school lessons. 
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CHAPTER 3 
 
BACK UP AND RESTORE 
 
Apostolic Bible Curriculum’s Back Up and Restore utility provides a convenient way to copy 
students’ work and grades for back-up purposes.  It is very important that the teacher (or 
student) maintains daily back-ups of student work.  If something should happen to the 
computer’s hard drive, all student work could be lost. 
 
The “Back Up Student Data” control copies student answers into a single large file.  This file 
can be loaded on a floppy disk (or disks), a ZIP drive, a network, or on another hard drive. 
 
Important Note:  If you are using floppy disks, use new disks every two to four weeks, as 
floppies can go bad. 
 
BACKUPS (Normal Operation) 
 

1. Click on the Back Up Student Data button near the bottom of the Student Menu 
(opening screen) or on the Teacher Menu. 
The following will open up: 
 

(See Advanced Features later in the chapter for information on changing your options.) 
 

2. Insert a blank, formatted floppy disk.  You may need two or three if you have several 
students.  Note:  Apostolic Bible Curriculum does not format or erase the floppy disk 
for you. 

3. Click on the Back Up button.  Another dialog box opens. 
4. Click on OK to back up to the A: (floppy) drive, or select another location.  The file 

name will be SOS.bak unless you change the name.  The computer asks for another disk 
if it runs out of room. 

5. Once the back-up is complete, the program will confirm that the back-up was 
successful.  If all your back-ups fit onto one floppy disk you will not see the validation 
process unless a corrupt file is found.  If your back-up required multiple floppy disks, 
you will be prompted unless a corrupt file is found.  If your back-up required multiple 
floppy disks, you will be prompted to reinsert them (order does not matter) for file 
validation.  You can cancel the validation process at any time.  If you do have a corrupt 
file on your floppy disk, run the back up again on a new floppy disk and throw the 
corrupt disk away.  Do not use the corrupted disk.  When the validation is complete you 
are told how many files were backed up.  Keep back-up disks in a safe place. 

 
BACK-UPS SHOULD BE MADE REGULARLY TO PROTECT AGAINST LOSS OF 

STUDENT WORK! 
 

RESTORE* 
 
If you ever need to restore a copy of your students’ work (after a hard drive crash, for 
example), insert one of your back-up disks (the order is NOT important), click on the Restore 
Data button, then the Restore button, and select (click on) the file on your floppy disk when it 
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asks for a file (SOS.BAK unless you changed the name).  Click on OK.  Repeat this process 
with any other back-up disks. 
 
ADVANCED FEATURES FOR BACK UP/RESTORE 
 
The advanced filter controls allow you to back up and restore specific parts of the student data. 
 

• You can Back Up or Restore a single student by entering the desired student number at 
the line labeled “Student Number.”  (You can view the student number in Student 
Setup.) 

• You can Back Up or Restore a specific subject by entering the subject name at the line 
labeled “Subject.” 

 
For example: 
 

• You can type in the full name such as “history 8” or “Language 11” using either upper 
case or lower case letters. 

• You can enter the actual directory name such as “BIB0802” or “SCI1002.” 
• You can enter the first three letters of a subject to get all grades of that subject such as 

“bib,” “his,” “mat,” “sci,” or “lan.” 
• You may use upper or lower case letters. Note:  For custom subjects you must use the 

“source” name (i.e. the name of the subject CD-ROM, not the name you made up for 
the custom subject.) 

• You can Back Up or Restore a specific unit by entering that unit number at the line 
labeled “Unit Number.” 

• If you check the “Prompt for each file” box, you will be asked to approve each file. 
 
Note:  You should at least do one full back-up (everything set to All) to record the school 
calendar, student names, and other data. 
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CHAPTER 4 
 
OVERVIEW OF CONTROLS & MENUS 
 
STUDENT MODE/TEACHER MODE 
 
Students and teachers share the same menus but access different controls.  In Teacher Mode, 
teachers can access all controls, curriculum, and answer keys. 
 
To get to Teacher Mode from the opening screen (Student Menu), scroll down until you see an 
icon that says, “Go To Teacher Mode.”  Click on the Go To Teacher Mode icon.  To get back 
to Student Mode, click on the Go To Student Mode icon.  This concept is key to understanding 
the Apostolic Bible Curriculum system; you are always in either Teacher Mode or Student 
Mode, and you need to return to the starting menu to switch between them. (See the diagram on 
page 24.) 
 
CONTROLS 
 
The side toolbar will help you move around in Apostolic Bible Curriculum.  The controls and 
their alternate keyboard commands are the following: 
 
DONE (or Esc key) takes you back to the previous (higher) menu; saves changes on current 
menu.  
 
Scroll Bar moves the screen up and down when you click and drag in either direction.  
 
Help (or F1) opens the Help file. 
 
Next (or F2 or right-click) goes to the next presentation or problem. 
 
UTIL (or F3) displays a list of utilities.  You can then choose between custom functions, 
problem helps, printing, and autohighlight. 
 
QUIT (or F4) exits Apostolic Bible Curriculum; does not save menu changes. 
 
KEY (Shift Key or F5) displays the answer key.  F5 “locks” the answer key open. 
 
Apostolic Bible Curriculum includes other keyboard controls: 
 
PAUSE key (or CTRL M) displays the subject-specific message box while in a lesson.   
 
CTRL-Click on a student’s name on the Teacher Menu takes the teacher directly to Student 
Setup. 
 
CTRL P while in Teacher Mode will print the screen or the lesson. 
 
SHIFT-Click on a unit button in the Grading Menu skips over the unit. 
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CTRL-Click on a unit button in the Grading Menu returns the unit settings to the default 
settings. 
 
SHIFT-Click on a video graphic to play the video full-screen.  
 
RIGHT-Click on a video graphic to play the video in a loop (i.e., plays repeatedly). 
 
SHIFT Right-Click on a video to play the video repeatedly full screen. 
 
Click on a Slide Show to go to the next slide.  Full-screen Slide Shows let you scroll over large 
graphics by moving the mouse pointer to the edge of the screen. 
 
The mouse pointer touching the edges of the screen moves the screen up, down, right and left.  
 
The Cursor or Arrow keys scroll the screen up, down, right, and left except when you are in a 
“text-entry” box.   
 
Page Up/Page Down keys move the screen up and down a page. 
 
Home/End key move the screen to the beginning and end of the page, respectively. 
 
MENU OVERVIEWS 
 
The menus in Teacher and Student modes are similar, but the teacher’s menus contain more 
options and controls. 
 
Teacher Mode 
 
Teachers have access to three menus within the Teacher Mode:  Teacher Menu, Grading 
Menu and Unit Grades Menu. 
 

1. Teacher Menu 
 
Click on Go To Teacher Mode to open the Teacher Menu.  The Teacher Menu displays 
the class list with student names labeled on icons.  From this menu teachers can add or 
delete students, enter School Setup, or access an individual student’s work.  We 
recommend that teachers set up a password to restrict access to the Teacher Menus.  
This can be done in School Setup. 
 
From the Teacher Menu you can: 

• See the complete class list*. 
• Add a student*. 
• Go To Student Mode. 
• Got to School Setup. 
• Back Up/Restore*. 
• View Scope and Sequence. 
• Export Scores. 
• Set theme for Teacher Mode. 
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2. Grading Menu 
 
Click on a student’s name in Teacher mode to open the Grading Menu.  This menu 
shows what the individual student is working on, what his current grades are, and what 
needs to be graded by the teacher. 
 
From the Grading Menu you can: 

• See assigned subjects. 
• See “Past Due” and “Needs Grading” notices on the appropriate subjects. 
• Go into the curriculum to grade*. 
• Open Student Setup:  name, password, assign subjects*, customize. 
• Print grades. 
• Access Student Records*. 

 
3. Unit Grades Menu 

 
The Unit Grades Menu allows the teacher to take a closer look at the student’s work.  
Similar to opening a textbook to the Table of Contents, clicking on a unit button in the 
Grading Menu opens up a content list.  The lesson titles are displayed as well as options 
to clear grades and assign or skip a lesson*.  By clicking on a particular lesson button, 
teachers can preview the content or review student work. 
 
From the Unit Grades Menu you can: 

• See the contents of the unit; view the presentations and problems. 
• Customize a project*. 
• Print the lessons. 
• Adjust grades, clear student work, skip problems, assign/skip/block lessons*. 
• View the due dates of individual lessons. 
• View the total score, the unit grade, time spent in lessons, time and score of the 

vocabulary and spelling games, starting and ending times for student work in a 
unit. 

 
Student Mode 
 
Students have limited access to the same three main menus as teachers do.  In Student Mode 
the three menus are:  Student Menu, Schoolwork Menu, and Review Menu. 
 

1. Student Menu 
 
The Student Menu displays the class list with the student names labeled on icons.  
Students click on their names to access their daily work.  
 
In the Student Menu: 

• If student passwords have been entered, students can gain access only to their 
own work. 

• “Go To Teacher Mode” option is available (this option can be password-
protected). 

• Students can back up their schoolwork. 
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2. Schoolwork Menu 

 
The Schoolwork Menu displays the student work assignments.  To begin working, a 
student clicks on a subject or project bar. 
 
In the Schoolwork Menu: 

• Click on a subject or project bar to see messages, due dates, and study options. 
• View current grades in unit grid below subject bars. 
• Click on a button in the unit grid to review a completed unit. 
• Set theme for student’s desktop. 
• View lesson plan. 

 
3. Review Menu 

 
To review completed lessons, students can access their work through the Review Menu.  
Similar to opening a textbook to the Table of Contents, clicking on a unit button in the 
Schoolwork Menu opens up a content list.  The lesson titles are displayed along with the 
grades earned.  By choosing a particular lesson, students may see their completed work 
and review for the quizzes and tests.  Students cannot, however, modify their work. 
 
In the Review Menu: 

• Browse a unit’s table of contents, listing the lesson titles, reports, quizzes and 
tests. 

• Access the presentations and problems that have already been completed. 
• See grades and due dates. 
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CHAPTER 5 
 
SETTING UP 
 
BASIC SETUP 
 
PART 1 – Set up the school: (1) enter a Teacher Password; (2) set the calendar for the 
school*. 
 
PART 2 – Set up the students: (1) add student names to the program*; (2) assign students 
their work*; (3) assign student passwords; and (4) create lesson plans. 
 
PART 1: School Setup 
 
To set up the teacher password and school calendar, you need to be in School Setup. 
 
To get to School Setup:  

• Click on Go to Teacher Mode. 
• Click on School Setup. 

 
1. Teacher Password: 

 
The teacher password is needed to block students from the answer key and teacher controls.  
It also enables the Problem Helps utility options, allowing teachers to take a look at look at 
the answer key while helping a student who is working in a lesson. 
 
Make up a password and type it in the box labeled “Teacher Password” at the top of the 
screen.  
 
If you forget your password, you can access Teacher Mode by holding down the shift key 
and clicking on the Go To Teacher Mode icon.  This action will erase the teacher’s 
password and allow you to type a new teacher password. 
 
Important Note:  Students can also clear the teacher password.  There are two simple ways 
to tell if the teacher password has been tampered with: (1) if you can get into Teacher Mode 
without a password, it means someone has erased the teacher password, or (2) if your 
password is no longer valid, it means someone has erased your password and created a new 
one. 

 
2. Set Calendar for School (use only if more than one student)*. 

 
In School Setup: 

• Click on Set Calendar for School; change the starting calendar year if you 
need to. 

• For each calendar month, select all days appropriate to your school’s 
schedule.  Click a box to select.  Click again to deselect. (Time-saving tip:  
Choose Load Default 180-Day Calendar at the top of the screen; then make 
changes to the calendar days.) 
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• Click DONE on the toolbar to save the calendar and return to the School 
Setup menu. 

 
Note:  To save changes in School Setup select DONE on the toolbar or press the ESC key.  
If you do not want to save changes, click EXIT on the toolbar.  Selecting DONE will save 
your changes and take you back to the Teacher Menu. 

 
PART 2: Student Setup 
 
You will set up students one at a time.  Follow these steps in order for each of your students. 
 

1. Add/Delete a Student*: 
• Click on Go to Teacher Mode. 
• Click on Add Student. 
• Type in the student’s name and click OK.  Student Setup will display. 

 
Note:  To delete a student, hold down the shift key and click on the student’s name in 
the Teacher Menu.  Alternatively, go to Student Setup and click on the button Delete 
this Student.  This will erase all the student’s work and grades and CANNOT BE 
UNDONE. 

 
Student Number 
 
Student numbers are automatically assigned in the order the students are added.  
Students keep these numbers even when other students are deleted, changing the total 
number of students.  You may need to know the student number when you do the 
student back-ups and restore any lost data. 
 
If you are following these instructions in order, note that Steps 2-4 below will take place 
in Student Setup, so stay on this screen.  You will assign subjects and customize the 
program for each student in their respective Student Setup menus. 
 
Note:  You can have up to five students in the Home version of Apostolic Bible 
Curriculum. 
 

2. Assign/Unassign Subject(s)*: 
 

The list of installed subjects is displayed below the student’s name at the top of the screen. 
 
Assign 

• Click on the box next to the subject to assign it.  An “X” appears in each selected 
box.  A subject bar for each assigned subject appears at the top of the Student’s 
Schoolwork menu. 

 
Unassign 

• To unassign a subject, click again on the box and the “X” disappears.  This disables 
the subject, and the subject bar will not appear on the student’s Schoolwork menu. 
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Note:  Unassigning a subject does not delete the student’s work.  The work will re-appear 
when the subject is re-assigned. 
 
Note:  When you add additional subjects, remember to return to Student Setup to assign the 
new subjects. 
 
3. Assign Student Password: 

 
In Student Setup: 

• Type Password in the box labeled “Student Password.” 
 

4. Create Lesson Plans: 
 
Apostolic Bible Curriculum generates lesson plans based on your calendar and assigned 
subjects.  
 
In Student Setup: 

• Click on Create Lesson Plan, double-checking to make sure the year listed is correct. 
• Choose either your school calendar (if you have set one up), or the default calendar that 

came with the program, or simply click on the individual days to select them.  Time 
saving tip:  activate the school calendar or default calendar; then modify it to fit a 
particular student. 

• Click DONE to save the changes and return to the Student Setup menu. 
• Click DONE again to go back to the Teacher Menu.  This student is ready to work.  

(See Lesson plans for more information.) 
 
ADDITIONAL SETUP FEATURES 
 
Program Locations 
 
When you install the program, Apostolic Bible Curriculum automatically finds and links to 
your word processing programs and World-Wide Web browser.  Students will be linked to 
WordPad.  Teachers will be linked to Microsoft Word if Word is installed on the hard drive.  If 
you do not have Microsoft Word, the teacher’s word processor will be linked to WordPad.  If 
you would like to change the word processor or Web browser, follow the step-by-step 
instructions below. 
 
To change the Word Processor or World-Wide Web Browser: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Click on Locate to find the program you want, or shift-click on Locate to have 

Apostolic Bible Curriculum find the program for you.  Auto-locate looks in order for: 
word.exe, winword.exe, then WordPad.exe for the word processor.  For the Web 
browser auto-locate looks for iexplorer.exe, nsgold.exe, then netscape.exe.  (Note:  
Auto-locate may take a few minutes to find your program). 

4. If you need to locate the program yourself, you have to find the executable (.exe) file on 
your hard drive for the program you want.  Programs you have installed onto your 
computer are usually located in C:\progra~1.  Double-click on the folders on the right of 
the dialog box to see the contents on the left. 
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5. Choose the program you want by double-clicking on it, or by clicking on it once then 
selecting OK.  The location will be copied automatically into the “Location” line in 
School Setup. 

 
Notes: 

1. Your word processor must work in rich text format. 
2. You must have Internet access in order for your students to visit the World-Wide Web 

through the curriculum.  Students can access the Internet browser through the UTIL 
button on the toolbar or can link directly to specific web pages via the WWW links in 
the lessons. 

 
Utility Programs 
 
You can create links to programs on your computer (references such as a calculator or 
encyclopedia).  Students can then access these programs from the UTIL button or the toolbar. 
 
The basic procedure is the same to add all links: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Enter a name to describe the program to which you are making a link.  This name will 

appear as a button in the Utility box for the student to click on. 
4. Click on Locate. 
5. Find the executable (.exe) file on your hard drive for the program you want.  Typically, 

you will need to look in C:\Windows for accessory programs like the located in 
C:\Program Files.  Double-click on the folders on the right to see the contents on the 
left. 

6. Choose the program you want by double-clicking on it, or by clicking on it once then 
selecting OK.  The location will automatically be copied into the “Location” line in 
School Setup. 

 
If you already know the location of the program, you can skip these steps and type directly into 
the box.  Given the example entries in the previous graphic, the resulting “Custom Functions” 
buttons (under the UTIL function) would display like this: 
 
 
Student-Specific Icons on the Desktop 
 
You can set up a different icon for each of your students so that they can go directly to their 
Schoolwork menus.  To do this: 

1. Locate the light-switch icon (the shortcut used to open the program) on your desktop. 
2. Create a second short:  right-click on the icon and select Create Shortcut from the menu 

that pops up.  Another light-switch icon will appear on your desktop. 
3. Right-click on the new shortcut and choose Properties from the menu that pops up. 
4. In the line marked “Target” type a space after “C:\SOS\SOS.EXE” then type an “s” and 

the student number of the particular student for whom you are creating the shortcut.  
(You can find the student number by looking in the Student Setup of each student.) 

 
Examples: 
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C:\SOS\SOS.EXE S1 will set up a direct link to the Schoolwork Menu of the student 
with the student-number 1.  C:\SOS\SOS.EXE S2 will set up a direct link to the 
Schoolwork Menu of the student with the student-number 2. 

 
5. To rename the icon to the name of your student, right-click on the new icon and choose 

Rename from the menu that pops up.  Type in the student’s name. 
 

Note:  When the icons are set up for individual students, clicking “DONE” in the 
Schoolwork Menu returns the student to the Windows desktop instead of to the Student 
Menu. 
 
STARTING SCHOOL 
 
Once the basic student setup is complete, students can access their lessons and begin work.  
Students should read the Student Orientation chapter before they get started.   
 
Note:  Teachers should familiarize themselves with both Student and Teacher Modes 
before students start working.  Create a practice student that you can “play with.”  Learn 
what it is like to be a student.  Practice grading.  See Teacher Orientation for further 
suggestions. 
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CHAPTER 6 
 
CALENDARS 
 
Calendars were briefly discussed in Chapter 5, Setting up, as part of the setup procedures.  This 
chapter more fully describes the calendar and provides guidance for its use.   
 
The calendar must be set up in order to create a lesson plan.  There are two types of calendars:  
one for the entire school and one for every student.  When created first, the use in creating 
individual lesson plans.  If you only have one student, you do not need to create a School 
Calendar.   
 
AVAILABLE DATES 
 
The program sets the school and student calendar defaults at 2004 however, the setting can be 
adjusted to reflect any year from 1980 forward. 
 
For any year you enter, the resulting calendar page will post a twenty-four month menu of 
calendars beginning in January of the year of choice. 
 
The Load Default 180-day School Year automatically selects a standardized, nine-month 
school year running from late August to May, which you can modify for your own schedule. 
 
The default calendar is available only for 2000-2010. 
 
SCHOOL CALENDAR* 
 
To set up or change the school calendar: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Click on Set Calendar for School. (Type in the starting date for the school year if you 

need to.) 
4. Select your school days: 

 
Load Default 180-Day School Year loads a pre-programmed calendar. 
 
Use School Calendar loads the calendar you created in School Setup (a school calendar 
is recommended when you have more than one student; it will save you time). 
 
Clear Calendar erases the calendar. 
 
Continue From Now should be used when you make changes to the calendar partway 
through the year and want to adjust the lesson plan. 

 
5. Click on DONE to save. 

 
Note:  If you make a change to the school calendar after you have set up your students’ lesson 
plans, you will need to go back to the lesson plans and reload the calendars.  See Lesson Plans 
for more details. 
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STUDENT CALENDARS 
 
The individual student calendars are found within the lesson plan feature in Student Setup.  
Each student calendar is separate from all other calendars.  For multiple students, you can save 
time by transferring the school calendar to each student and the personalizing it.   
 
To set up or change a student calendar: 

• Click on Go to Teacher Mode. 
• Click on the student’s name. 
• Click on Student Setup 

 
In Student Setup: 

• Click on Create Lesson Plan, double-checking to make sure the year listed is correct. 
• Choose either your school calendar (if you have set one up), the default calendar that 

came with the program, or simply click on the individual days to select them.  Time-
saving tip:  use the school calendar or default calendar; then modify the days needed for 
this particular student. 

 
Note: Both school calendar and student calendar must be set to the same year if you are going 
to import the school calendar into the student calendar. 

• If you are changing a student’s lesson plan check the box labeled Continue From Now. 
(See Lesson Plans for more details.) 

• Click DONE to save the changes and go back to the Student Setup menu. 
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CHAPTER 7 
 
LESSON PLANS 
 
The automatic lesson plan feature provides a useful structure in which to set the schoolwork 
pace for each student.  When activated, the lesson plan feature generates a schedule by dividing 
the total number of assigned problems (as they exist in lessons, quizzes, and tests) by the total 
number of school days assigned to the student calendar.  Assigned projects appear in the lesson 
plan, but their completion status does not influence due date notices (see Due Dates below). 
 
Subjects are divided into units, lessons, quizzes, tests and projects.  A subject generally has 5-
11 units (most have 10 units).  The units are then divided into a number of lessons and projects.  
Each unit also has 2-5 quizzes and a final unit test. 
 
Note:  Suggestions are made at the end of this chapter for how you can modify the lesson plans 
for semester subjects and extended schedules. 
 
CREATING LESSON PLANS 
 
To create a lesson plan: 

1. Click on Go to Teacher Mode. 
2. Click on a student’s name. 
3. Click on Student Setup (If you have not already done so, assign subjects to that student 

by selecting from the list of installed subjects). 
4. Click on Create Lesson plan for school year starting in 2002 (change the date to 2001 if 

you are finishing off the 2001 school year.)  The calendar for this particular student 
displays. 

 
Choose on of the following buttons and/or select individual days. 
 
Load Default 1480-Day School Year loads a pre-programmed calendar.  (See Chapter 6, 
Calendars, for more details.) 
 
Use School Calendar loads the calendar you created in School Setup (a school calendar is 
recommended when you have more than one student; it may save set-up time). 
 
Clear Calendar erases the calendar. 
 
Continue From Now should be used when you make changes to the calendar partway through 
the year and want to adjust the lesson plan (see “Changing the Lesson Plan” in this chapter for 
more details). 
 

5. Click DONE to save the changes and create the lesson plan.  Follow the on-screen 
instructions.  

 
View/Print Lesson Plan 
 
To see the lesson plan and print out a copy, go to the Grading Menu (if you are still in Student 
Set Up, click DONE to go back to the Grading Menu) and click on the button View Lesson 
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Plan.  The lesson plan displays in the chosen word processing program. (Note:  Students can 
view their lesson plan from their Schoolwork Menu.) 
 
To print, select the “File” menu the “Print.” 
 
Lesson Plan Format (as seen in View Lesson Plan) 

• The left column is the subject name. 
• The middle column is the Unit Number:  Lesson. 
• The right column is the lesson name. 
• A lesson “P” is a Project; “Q” is a Quiz; “T” is a Test. 
• If “…” follows the name of the lesson, then that lesson continues to the next day. 

 
WARNING!  You cannot change the lesson plan by changing the text.  Lesson plans are 
generated by Apostolic Bible Curriculum using the assigned subjects are current calendar.  
Changing the text in WordPad or Notepad will have no effect on the lesson plan!  You can 
change the lesson plan only by changing the calendar or the assigned subjects and clicking on 
Generate Lesson Plan again. 
 
Due Dates 
 
Once lesson Plans have been generated, the program posts due dates on the Unit 
Grades/Review menu next to the assignment titles. 
 
Also, the due dates will be printed in the opening message box along with the lesson titles when 
a student clicks on a subject to begin work. 
 
Past Due! Notices 
 
Once the Lesson Plans have been generated, students will be warned by “Past Due” messages 
when they fall behind.  The Past Due notices are posted on the subject bar and in the title on the 
message box.  A student’s Past Due notice is updated every time the teacher goes into the 
Grading Menu for that Student.  Note:  Projects will not get Past Due notices posted to them. 
 
To turn off the “Past Due” warnings:* 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Click on Student Setup. 
4. Under “Learning Options” select Disable “Past Due” Notice. 

 
CHANGING THE LESSON PLAN 
 
After changing the calendar or adding subjects, you must regenerate the lesson plan. 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Click on Student Setup. 
4. Click on Create Lesson plan for school year starting in 2002 to display the calendar. 
5. If needed, make changes to the calendar by selecting days or loading preset calendars. 
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6. Select the option Continue From Now at the top of the page.  The new lesson plan will 
take into account the work completed, allowing the student to continue work with new 
due dates.   

7. Click DONE to save the changes and re-create the lesson plan.  Follow the on-screen 
instructions. 

 
DELETING THE LESSON PLAN 
 
To delete a lesson plan: 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Click on Student Setup. 
4. Click on Create Lesson plan for school year starting in 2002 to display the calendar. 
5. Click on Remove Lesson Plan to bring up the prompt, “This will rease the lesson plan 

for this student.” Select OK.  
 
CUSTOMIZING THE LESSON PLAN* 
 
Different length lesson plans for each subject: 
 
Lesson plans are based on your selected calendar.  As such, if you would like to extend the 
lesson plan for just one or two subjects, you will have to either ignore the lesson plan, or add 
another student in order to create separate lesson plans for those subjects. 
 
Note:  In the home version of Apostolic Bible Curriculum you can have up to 5 students at a 
time. 
 
Semester Courses (5-8 units): 
 
If you use a 180-day calendar, the lesson plan will spread the course out over the entire school 
year.  If you would like your student to finish a course in one semester, either create a semester 
calendar for this subject or ignore the lesson plan.  
 
To create a semester calendar for one subject, add another student that is assigned only that one 
subject.  You can then create a shorter calendar so the due dates reflect a semester time-frame. 
 
Alternatively, if your student is completing two semester courses over a one-year period, you 
could create a custom subject combining the two courses back-to-back, and use the standard 
180-day calendar.  See Custom Subject for details on how to combine subjects. 
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CHAPTER 8 
 
TEACHER ORIENTATION 
 
This brief orientation will help you get started in the Apostolic Bible Curriculum by explaining 
what you can do in the program.  By reading this section, you will more readily understand the 
step-by-step instructions found in other chapters. 
 
Apostolic Bible Curriculum is your curriculum, teacher handbook, answer key, and grading 
book all wrapped up in one educational learning system.  If you are new to the Curriculum, you 
will find the first few weeks to be a period of adjustment to computerized education.  This is to 
be expected, but before long you will be sailing through the various menus and pinpointing the 
areas where your students need your help the most.  The computer is not meant to replace you, 
rather to save you time by taking care of administrative tasks and simple grading. 
 
GETTING ORGANZED 
 
Apostolic Bible Curriculum is designed to give you the flexibility to make important, 
education-related decisions as you see fit.  The following is a summary of some of the available 
options and a list of suggestions for using them. 
 
Lesson Plans – The lesson plan is a guide to keep you on track throughout the year, based on 
the calendar you set up.  If you go on an unexpected vacation, or your student gets ill, you can 
make changes to the calendar and print out a new lesson plan.  You can also use this lesson 
plan for you student’s records. 
 
Customizing the Curriculum* - Teacher Mode allows you to adjust the curriculum to meet 
your students’ needs.  You can look over the curriculum ahead of time so you know what your 
student will be doing.  You can choose to skip over lessons, skip over questions, or even re-
arrange units. 
 
Assign or Skip Projects* - You can change which projects are “assigned” and which are 
“skipped.”  Click on the project title to preview the assignment and decide if you want your 
student to complete the work. 
 

Teacher Tip*:  Go before the students and “block” all the quizzes and tests.  
That way, your students must let you now when it is time for a quiz or test.  You 
can then check their work to make sure they are ready for the test. 

 
Add Your Own Project* - Each unit has a lesson called “Special Project.”  This lesson is 
available for you to create your own assignment and incorporate it into the grading.  You can 
use this space for field trip reports, book reports, or current-events project. 
 
Create a Custom Subject* - You can combine any subjects across any grade levels and 
rearrange units. For example, say your 7th grade math student is missing some key concepts 
from 6th grade.  You can create a custom subject by taking two units from 6th grade and adding 
those to the beginning of his 7th grade math.  The automatic lesson plan will then spread that 
work out over the course of the school year so that he finishes all of it within the year and has 
caught up on what he was missing (see Customizing the Curriculum chapter for more info). 
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Teacher Tip:  Important!  Get comfortable with using the Unit Grades Menu.  
This menu acts as the table of contents for the unit, allowing you access to the 
lessons and your student’s work.  It is an important menu for grading and 
helping your students. 

 
Learning Options* - There are many ways for you to customize the program in School Setup 
and Student Setup.  The program settings influence how the student interacts with material in 
Apostolic Bible Curriculum. 
 

Focus Learning – Focus Learning is a “mastery loop” that cycles students back to their 
incorrect answers.  Students need to have 100% in the lesson before continuing.  (Not 
used in quizzes or tests.) 
 
Open Page/Open Book – Open Page and Open Book are alternate setting for quizzes 
and tests.  The default setting does not allow the student to cycle through the problems, 
or leave an incomplete quiz or test. 

 
DAY-TO-DAY 
 
Handling student questions – Your students will probably have questions as they progress 
through the material.  If you are on hand to field questions, you can pop into Teacher Mode to 
look at the Answer Key.  Your experience and the Teacher Mode answer key should be 
sufficient to answer all immediate student questions. 
 

Teacher Tip:  You do not have to be in Teacher Mode to see the answer key.  
In Student Mode, simply click on UTIL on the toolbar to access Problem Helps, 
a password-protected look at the answer key. 

 
If you are not available to field questions, students can skip a troublesome problem by typing a 
note and sending the problem to you.  Messages from the student are indicated by a flashing 
“Message” notice located near the problem number.  To read the message, click on the little 
notepad located beside the problem number. 
 

Teacher Tip:  Concepts build upon each other, especially in Mathematics and 
Language Arts.  When you are helping your students learn a new concept, you 
may have to review the basics with them before they can fully grasp new 
content.  If necessary, you can go back and clear an entire lesson for the student 
to repeat. 

 
Grading* - You will want to follow behind the student to grade essays and paragraphs and 
read any messages left for you. 
 
In Teacher Mode, Grading Menu, the “Needs Grading” notice appears on a subject notifying 
you that problems need you grading and/or attention.  Click on that notice to go directly to the 
problems needing attention. 
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Teacher Tip* - Even if there is no “Needs Grading” notice, use the Unit Grades 
Menu to look through the lessons, paying particular attention to incorrectly 
answered problems.  These will be colored red so you can quickly spot them. 
 
Teacher Tip* - If you disagree with a grade, you can click on the score box and 
change the score.  For example, the student might spell a word so that the 
program does not recognize it as being the correct answer:  You can override the 
grade by giving partial or full credit. 

 
You can also set up a “Study Student” for the student to practice his or her lessons on before 
taking a quiz or test.  Simply add another student* and assign the same subjects, skipping over 
the lessons that are not needed for review.  Note:  You will want to “skip: all the quizzes and 
tests so the student doesn’t practice on those before taking the real ones! 
 
Back-ups – Get into the habit of keeping regular back-ups of your student’s work.  This is very 
important to protect against losing weeks, even months of work.  Students can back up their 
own work through the back-up button on the Student Menu. 
 

Teacher Tip:  The toolbar controls have matching keyboard controls.  For 
example, pressing the F2 key is the same as clicking on NEXT.  F3 is the same 
as the UTIL.  See Controls in Chapter 2 for more keyboard controls. 

 
Help File 
 
If you ever need more instructions on how to perform an activity in Apostolic Bible 
Curriculum, click HELP on your toolbar.  The Help file is “context sensitive” which means it 
will open to the page that matches what you are working on.  For example, if you are in Student 
Setup and click on HELP, the Help file will open to the explanation of Student Setup. 
 
To search for a topic in the Help file, click on Search.  In the index tab, type in a keyword, for 
example, “Printing.”  Highlight the index entry you want, then click Display.  If the keyword is 
found on more than one page, choose the page you want, then click Display.  Scroll down the 
help page to find you topic.   
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CHAPTER 9 
 
STUDENT ORIENTATION 
 
If this is your first year with Apostolic Bible Curriculum, there are a few things that you need 
to learn about doing your schoolwork on the computer before you begin your studies. 
 
GETTING STARTED 
 
Double-click on the light-switch icon on your desktop to enter the Curriculum.  If you have an 
icon set up just for you, you will go directly to your Schoolwork Menu.  If all the students and 
the teacher are using the same icon, you will have to look for your name in the opening menu, 
the Student Menu. 
 
Click on your name and type in your password (if your teacher gave you one) to get to you 
Schoolwork Menu. 
 
The Schoolwork Menu displays the subjects you are studying and posts your grades.  To start 
working, click on a subject icon near the top of the screen.  You must have that subject’s CD-
ROM in your CD drive to access your lessons. 
 
Note:  If you do not have any subjects assigned yet, tell your teacher. 
 
DAILY LESSONS 
 
Each of your subjects is divided into units, lessons, quizzes, tests, and projects.  Each unit has 
2-5 quizzes and a final unit test.  The lessons always start off with text information for you to 
read followed by problems for you to answer. 
 
To get, started click on a subject icon.  A message box opens, providing a place for you and 
your teacher to send each other questions, answers, and announcements.  (You can read more 
about message boxes in Chapter 14, Messages.) 
 
Click on Start Lesson at the top of the message box to begin you schoolwork. 
 
Multimedia – As you read through your lessons you’ll find a variety of multimedia items to 
click on.  Look for words colored blue, tiny video-recorder and speaker symbols on pictures, 
and the instructions to “click here.”  When your mouse pointer turns to a little hand, click to see 
what happens.  Some presentations you click on will play on their own (videos), but for other 
presentations, you will have to click through at your own pace (slide shows). 
 
Lesson Problems – When you finish reading a lesson, click on NEXT on your toolbar.  The 
first problem pops up at the bottom of the screen.  Answer the problem and then click NEXT.  
Your answer will be graded immediately.  A correct answer leaves the problem on the screen 
so you can take another look at it.   Sometimes you will even be shown a “hint” about the 
correct answer to the problem.  When you get a problem wrong, the background screen 
displays “Incorrect: Click Next to Continue.”  You cannot change the answer at the point.  
Click NEXT to move on. 
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If you need help in figuring out how to use the computer to answer a question or solve a 
problem, click on the HELP button on your toolbar for an explanation. 
 

Student Tip:  Learn to use the keyboard and mouse shortcuts!  Instead of 
clicking NEXT on the toolbar, you can press the F2 key on your keyboard or 
you can right-click with the mouse.  To learn more keyboard controls see 
Controls in Chapter 1. 

 
Spelling – Spelling counts in fill-in-the-blank questions (short answers).  Words that are only 
“close to” the correct spelling will get points taken off or may be marked completely wrong. 
 
Focus Learning – If your teacher has you in Focus Learning (default mode), you will be in 
mastery loop where you automatically return to the problems marked incorrect.  Correct your 
answer and then click on NEXT.  You will keep coming back to these problems until all are 
graded 100%.  (Focus learning operates only in lessons, not quizzes or tests.) 
 
I’m stuck! – If you are having trouble with a question and your teacher is available, you can 
use the Problem Helps found in the UTIL button on the toolbar.  Click on UTIL and choose 
from the options of “Give-up” (get a score of zero), Skip (go past), or Answers (see answer).  
Your teacher will then have to type in the Teacher Password to continue. 
 
When you click on UTIL, this box will open: 
 

Student Tip:  The UTIL button provides another way to access the message 
box.  You can also link to other programs (ask your parents to set these up) and 
use the autohighlight tool when studying completed lessons. 

 
 
If your teacher isn’t available right away, you can leave a note and move on.  Click on the 
small notepad near the problem number.  Type in a message explaining the trouble you are 
having and then click on “Leave message for teacher; skip problem.”  The problem will then be 
sent to the teacher; and you will be able to continue on with your work.  If your teacher has 
turned off this feature, you will not be able to skip the problem. 
 
GRADING 
 
Your teacher grades all paragraph answers and projects.  Your teacher may also change the 
grades on any computer-graded problems.  Your grades are not final until your teacher, not the 
computer, says they are final. 
 
Work sent back – Sometimes you will find yourself automatically put back into a lesson that 
you thought you had finished!  Your teacher, who is following behind you, grading and 
answering your messages, has changed something and wants you to see it.  You might have to 
redo some work.  Check in the flashing message box to see what your teacher wants you to do.  
If there is no message, redo the problem, and go on. 
Grades – The grades for all your subjects are displayed on the buttons at the bottom of the 
Schoolwork Menu.  Each unit is represented by a button.  Click on a unit button to see the unit 
table of contents and the grades for each of the lessons (i.e., the Review Menu).  Click on a 
lesson to see the grades for each of the problems. 
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STUDYING FOR QUIZZES AND TESTS 
 
Review 
 
The message box leading to each lesson has the option “Review Previous Lesson.”  Click this 
button to go to the Review Menu. 
 
The Review Menu is a table of contents listing all your lessons and projects for the unit.  Click 
on a lesson title to see the lesson.  You can scroll through the entire lesson and see all the 
problems.  Click on KEY on the toolbar to compare your answers with the answer key.  If you 
don’t quite understand the lesson material, go back over it.  Ask your teacher to review it with 
you. 
 
You can also get to the Review Menu through the Review buttons on your Schoolwork Menu.  
Each subject has a row of 5 to 11 buttons that link directly to the “table of contents” for each 
unit. 
 
Note:  You can only revisit the lessons you have finished.  You can change the answers. 
 
Autohighlight – While in any assignment in Review Mode you can use “Autohighlight” in the 
utilities box to find a topic you want to study.  Click on UTIL on the toolbar.  Type in a word or 
phrase in the Autohighlight box and click Find.  All instances of the word or phrase you typed 
will be highlighted for you. 
 
Reference – Each unit has its own Reference section.  Here you will find all your vocabulary 
words, web links, and videos listed for that unit.  The reference sections may also contain 
formulas, memory verses, or other information depending on the subject. 
 
To access the Reference section, click on UTIL on your toolbar or go to the Review Menu; 
Reference is at the bottom of the lesson list. 
 
Note-taking – Another way you can study is to take notes from the lessons.  Write down the 
important ideas, patterns, and formulas.  Find a method of note-taking that works for you.  
Your teacher can help you with this. 
 
“Pre-test” – One way to review your schoolwork is to ask your teacher to clear a lesson for 
you to redo.  Study first, then see if you can go through the lesson and answer all the questions 
without looking at the text for answers.  You can also ask your teacher to set up a “Study 
Student” so you can do the lessons over again without deleting your real work. 
 
Practice – Make sure you practice each new skill you learn.  If you are studying Spanish, 
practice you pronunciation.  If you are learning calculus, do extra problems.  Many of the Web 
links in Apostolic Bible Curriculum will lead you to Web sites that will give extra practice.  
Use these sites. 
 
TYPES OF QUIZZES AND TESTS 
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There are three different styles of quizzes and tests available in Apostolic Bible Curriculum.  
Your teacher decides which kind to give you. 

1. Default setting – In the default quiz setting you answer one problem at a time, just like 
in the lessons, but you will only get one chance to answer.  You will not loop back to 
the beginning of the quiz.  Problems will be graded as you complete them.  In this 
mode, make sure you have given your FINAL answer before you click NEXT.  Once 
you leave the quiz or test, you cannot go back in.  All unanswered questions will be 
graded as “0” points. 

2. Open Page – In an open page quiz, you answer one problem at a time and you can 
continuously loop through the questions until you click DONE.  Nothing will be graded 
until you click DONE.  Once you leave the quiz or test you cannot go back in.  All 
unanswered questions will be graded as “0” points.  

3. Open Book – Like “Open Page,” Open Book quizzes allow you to continuously cycle 
through the problems until you click DONE.  You will also be able to exit or enter the 
quiz or test at will.  All unanswered questions will be graded as “0” points. 

 
PROJECTS 
 
Project icons will pop up on your Schoolwork Menu throughout the year.  These may be 
Science experiments, essays, or other projects.  Click on a project icon to view the assignment.  
You can go in and out of a project until you click on the button “Check here when your project 
is complete” at the top of the instructions page.  Clicking this button sends the project to you 
teacher. 
 
Generally, you will use a word processor to complete projects.  Click on the Report icon to 
open a word processor and type your answer.  When you save your work, do NOT change the 
name of the project.  Click “Save” NOT “Save As.” 
 

Student Tip:  Work on these projects as they come up.  If you wait too long to 
get started, you’ll end up buried under a pile of projects. 

 
Help File 
 
If you ever need help with the program click on HELP on your toolbar.  The Help file is 
“context sensitive” which means it will open to the page that matches what you are working on.  
For example, if you come to a drag-and-drop problem and you do not know what to do, click 
on HELP and the Help file will open the explanation of “Drag-and-Drop.” 
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CHAPTER 10 
 
STUDENT ACTIVITIES 
 
Lessons are supplemented by diagrams, pictures, and multimedia interactions.  Students read 
the information then click on NEXT (F2) to see more information or begin a set of problems, 
students click on NEXT and their answers are instantly graded.  When Focus Learning is used, 
students will remain in a lesson until all the problems are answered correctly (mastery loop). 
 
MULTIMEDIA 
 
Education comes alive through multimedia!  Science experiments performed by our in-house 
science team are caught on video.  In geometry, three-dimensional objects are illustrated 
rotating in space.  Video clips illustrating events in the Bible, literature, and history have been 
obtained from our extensive video library and are used to enhance the curriculum.  Sound 
captures of the vocabulary words allow students to hear how each word is pronounced, and 
spelling tests are given directly by the computer.  Students can print charts or forms for various 
activities such as drawing graphs or conducting surveys. 
 
Sound Clips 
 
Sound clips are indicated by words in blue type or by a gold speaker symbol located at the 
bottom right corner of a graphic (see above). 
 

• Click on the word in blue type to hear the sound (vocabulary pronunciation, poetry, 
Scripture readings, etc.)  Note:  Sorting and matching problems also use blue type, but 
no sound will be heard when you click on these words.  Instead, the word will be 
highlighted in black. 

• If you see a gold speaker symbol at the bottom right-hand corner of a graphic, click on 
the graphic-you may have to wait a few seconds-and the sound will play. 

 
Vocabulocity and Alpha 14 
 
Apostolic Bible Curriculum brings vocabulary drill into the world of science fiction with 
Vocabulocity and it sequel Alpha 14.  Students read a volcabulary definition, fly through a 3-D 
world (with many distractions), and attempt to choose the correct vocabulary word to match the 
definition by moving the mouse pointer to “open ports” or “air locks.”  These are more than 
mere matching games-students have to remember their definitions.  Vocabulary games are 
ungraded; game statistics are recorded in the Unit Grades and Review Menus. 
 
Note:  Vocabluocity must be installed on your computer in order to play it.  (See Installation 
Options.) 
 
Spelling Bee 
 
Students can practice their spelling in a race against time.  The game says a word aloud, and the 
student must type it correctly.  Each round is taken from the lesson-based vocabulary or 
spelling list.  Students can play multiple games in order to beat their time.  The game continues 
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until all words in the list have been spelled correctly.  Like the vocabulary games, this activity 
is ungraded. 
 
Note:  Spelling Bee must be installed on your computer in order to play it. (See Installation 
Options.) 
 
Switched-Curriculum complies statistics on the amount of time spent in vocabulary/spelling 
games as well as the number of tries, and number of wins.  Go to the Review Menu (for 
Students) or the Unit Grades Menu (for Teachers) to see these.  Vocabulocity, Alpha 14, and 
Spelling Bee can be disabled in Student Setup. 
 
Animations and Video Clips 
 
Computer animations or video clips are marked by a gold video camera icon located at the 
bottom right-hand corner of a graphic or picture. 
 

• Click anywhere on the picture to play the video clip one time. 
• Click with the right mouse button to play the video continuously. 
• Hold the Shift key down while clicking (with either right or left mouse button to play 

the video full screen.  
• To stop the video, click anywhere with the mouse button. 

 
Slide Shows 
 
Slide Shows are a combination of graphics and sound.  Students control the pace of the 
presentation by clicking on the graphic when they are ready for the next picture.  Full-screen 
slide shows let the student scroll over large graphics (the student moves the mouse pointer to 
any edge of the screen). 
 
Animazing 
 
Animazing presentations are a cross between a slide show and a video clip.  Click to start these 
presentations and they run on their own like a video; however, the video symbol does not 
appear. 
 
Tiny Tutors 
 
Like a sidebar in a magazine, Tiny Tutors highlight interesting information, tie concepts 
together, and direct the student’s attention to important or difficult concepts in the curriculum.  
Click on the graphic to start and stop the video. 
 
Print-out Feature 
 
Print-outs are available for students to help them complete some of their projects.  Instructions 
direct the student to click on a graphic or words in blue type to print items such as graph paper, 
star charts, or detailed instructions. 
 
Internet Links 
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If you have Internet access, your students can visit the World-Wide Web through the UTIL 
button on the toolbar or form within the curriculum wherever they see an animated “WWW” 
icon.  Clicking on WWW links in the curriculum will start the browser at a designated web 
page.  You can set up the link to your web browser in School Setup and disable access in 
Student Setup. 
 
Review Prompt 
 
Before a quiz or test begins, the message box prompt will open with the questions:  “Have you 
reviewed for this quiz?”  Options are given to Cancel, Review for Quiz, or Start Quiz.  Review 
for Quiz sends the student to the Review Menu.  Selecting Cancel sends the student back to the 
Schoolwork Menu.  Selecting Start Quiz begins the quiz. 
 
PROBLEM TYPES 
 
Timed Problems 
 
Some problems are equipped with timers.  When the time runs out, the answers get graded.  
Students will be able to see a “counter” so they know when time is running out. 
 
Crossword Puzzles 
 
Crossword puzzles are set up in a simple grid pattern using letters and numbers.  Clues help the 
students find the answers.  Press the up/down arrow keys to type a word vertically; press the 
right/left arrow keys to type a word horizontally.  Two- or three-word answers are separated by 
blank white spaces. 
 
Drag-and-Drop 
 
Used to label maps and diagrams or to set up algebraic equations, drag-and-drop graphics allow 
students to “pick up” items from a menu, drag them to the main graphic, and drop them into 
position.  The menu of icons to drag is located below the main graphic. 
 
Click on the selected item and, holding down the mouse button, slide the mouse to move the 
item to the correct position.  To drop an item, release the mouse button.  Dragging selected item 
off the main graphic or out of the active space will delete it.  Dropping a new item onto an 
already placed item will replace the old.  Menu items can be used more than once. 
 
Dynamic Learning Activities (DLAs) 
 
Dynamic Learning Activities: 

• Give students practice at a skill 
• Teach the proper way to complete a problem 
• Help teachers diagnose student errors 

 
Each DLA has a help screen to explain how to work the activity. 
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The States Game – Choose the correct state of the union after reviewing clues such as 
bordering states and major cities, including that state’s capital.  A correct answer gives the 
student the chance to place the state in its correct location on a United States map. 
 
The Chemistry Game – Balance equations by selecting the correct combination of numbered 
beakers and then “mixing” their contents.  This game appears in both graded and ungraded 
versions. 
 
The Chalkboard – Step up to the virtual chalkboard to work math problems. The game 
provides instant feedback, showing student errors and modeling correct processing skills.  
Versions of this game – both with and without decimals – include addition, subtraction, 
multiplication, and division. 
 
Timeline – Explore a wider historical context while memorizing important dates.  Click on a 
date (where linked) in a lesson to read about key historical events surrounding the lesson 
discussion or get the bird’s-eye view – from Creation to the Twenty-first Century. 
 
Teachers have three options when reviewing student work in DLAs: 

1. Click on the DLA graphic to see student’s work. 
2. Shift-click on the DLA graphic to see the correct answer. 
3. Right-click on the DLA graphic to run the activity (as thought you are the student). 

 
Note:  DLAs in quizzes and tests are not compatible with Open Page or Open Book modes 
because the program grades these activities immediately.  When the program is set to run in 
these modes, the DLAs will not appear.  
 
Matching 
 
Students can move the words in blue type in the first column to match the definitions or 
descriptions in the second column.  Students click on the word they want to move (it will be 
highlighted in black).  Then, they click on the location where they want to place the word.  The 
highlighted word will then change places with the word in that location.  Students can de-select 
a word (without moving it) by clicking on it again.  Students continue moving the words 
around until they have matched all the words with the descriptions. 
 
Multiple Choice 
 
Students can select only one answer in multiple choice problems.  When one round button is 
selected, all the others are deselected.  Students may select and deselect a choice any number of 
times before clicking NEXT.  Be careful-sometimes the best answer is “all of the above” or 
“none of the above.” 
 
Multiple Choice Text 
 
A blank textbox that automatically produces a word when you click on it indicates a multiple 
choice text question.  Possible answers are already typed in the textbox.  Students click in the 
box to cycle through possible answers.  The problem is completed when the correct answer is 
displayed. 
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Multiple Choice Graphics 
 
Students click on the graphic to reveal another, slightly different graphic.  The various graphics 
will continuously loop as students click on them.  The Student stops clicking when the correct 
graphic is displayed. 
 
Paragraphs 
 
Paragraph boxes are used to answer problems that require short sentence and essay answers.  
These paragraphs are sent to the teacher for grading so they will not appear again wit Focus 
Learning. 
 
WARNING!  Once students click on NEXT, they will not be able to get back to the paragraph 
box to change the answer. 
 
Selections 
 
Similar to multiple choice problems, selections allow students to choose none, one or more 
answers.  Click on as many boxes as apply to the problem.  The students may select and 
deselect a choice any number of times before clicking on NEXT. 
 
Sorting 
 
To alphabetize or place events in the proper order, students click to move the word in blue type.  
When a word is selected, it will be highlighted in black.  Students click on the location where 
they want the word to go, and the highlighted word will change places with that word.  
Students continue moving the words around until they have the correct order.  Sorting is similar 
to matching, but in quizzes and tests, sorted answers are graded according to their sequence 
rather than their specific position in a list.  This means students receive partial credit for 
partially correct answers. 
 
Text 
 
Apostolic Bible Curriculum employs an intelligent scripting system which allows for a variety 
of correct answers.  Students apply analytical problem-solving skills rather than rote 
memorization.  Apostolic Bible Curriculum even checks for spelling and can be set to subtract 
percentage points for misspelled words. 
 
A narrow, tinted box indicates a text-entry blank.  Most blanks require only one word or 
number, but some may require a very short phrase. 
 
To move from one box to the next, click on the desired box or use the Enter or Tab keys.  To 
delete letters, use the Delete or Backspace keys.  To insert letters, click on the box where you 
want to put the letters and begin typing.  The other letters will move to the right to make room 
for any inserts.  If you type too many letters, the end letters will be deleted. 
 
Preloaded Text – Sometimes the text-entry boxes already have words or sentences typed in 
them.  These problems generally require the student to correct something in that word or 
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sentence.  In these problems, Ggrading is very exact, right down to punctuation, spelling and 
capitalization. 
 
True/False 
 
Click on the T/F box to change back and forth between TRUE and FALSE. 
 
PROJECTS 
 
As students go through their daily work, projects are periodically assigned.  These projects 
contain a set of instructions or questions and are graded solely by the teacher 
 
Students access their projects by clicking on the project bars that appear on their desktops.  To 
send reports to the teacher for grading, students click on the box labeled “Check here when 
your project is complete.”  Until this box is checked, students may enter and leave projects at 
any time.   
 
Extra and Special Projects* 
 
Extra projects are initially skipped (unassigned).  The teacher can give additional work 
assignments by assigning these projects.  See the chapter on Customizing the Curriculum. 
 
Reports 
 
Reports are found within projects.  Clicking on the NEW REPORT icon launches a word 
processor where students may answer the given question(s).  Students may enter and leave the 
report at any time by saving any work, closing out of the word processor and clicking DONE or 
pressing the ESC key.  Once a report has been started, NEW REPORT will be labeled OPEN 
REPORT.  To send the report to the teacher for grading, students click on the box labeled 
“Check here when your project is complete.” 
 
Student Note:  When you have finished a report and exit your word processor, be sure to save 
your work.  Simply click on Save.  DO NOT click on “Save As” and change the file name.  
Apostolic Bible Curriculum links to the original file name. 
 
Teacher Note:  The project icon will not appear in the teacher’s Grading Menu until the 
teacher has graded past the lesson preceding the project assignment. 
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CHAPTER 11 
 
STUDENT LEARNING OPTIONS 
 
DEFAULT SETTINGS 
 
Lessons 
 
“Focus Learning” creates an environment that encourages students to stick with a lesson until 
all their answers are correct.  Students are placed in a mastery loop which returns them to 
incorrect lesson problems until all are answered correctly; this is similar to a teacher handing 
back an assignment for the student to correct his answers.  Focus Learning is not used during 
quizzes and tests. 
 
The Focus Learning System: 

• Acts as an automatic, self-adjusting lesson plan. 
• Creates an environment for efficient learning. 
• Acts as a built-in tutor. 

 
Students can “break out” of the mastery loop by using the Problem Note to leave a message for 
the teacher and skip the problem (See Problem Note in Chapter 14, Messages).  Teachers can 
also help students who are stuck on a problem by using the Problem Help and the teacher 
password to look at the answer key (See Answer key in Chapter 12, Grading). 
 
Quizzes and Tests 
 
The default setting for quizzes and tests requires students to answer questions one at a time.  
Students are given one attempt at answering; once they click NEXT the problem is graded and 
the next problem given.  Once they leave a quiz or test, they cannot return and all unanswered 
questions are graded as 0 points.  This form of testing prohibits students from guessing answers 
by use of context clues gleaned from other questions, providing a good measure of a student’s 
knowledge. 
 
CHANGING THE LEARNING OPTIONS 
 
The learning options can be modified for each student to adjust for learning styles.  The options 
are located under each student’s Student Setup menu in Teacher Mode. 
 
To change the Student Learning Option*: 
 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Click on Student Setup. 
4. Select from the following: 

 
Disable Vocabulocity* - (Option only appears if Vocabulocity is installed: see Installation 
chapter.)  Vocabulocity is a graphic-intense, 3D game created to challenge students to learn 
their vocabulary words and definitions.  How ever, because it is so much fun, some students 
may spend too much time rescuing “Vocabulo City.”  The disable function allows teachers to 
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turn off this feature.  To see how much time you students are spending in Vocabulocity, go to 
the Unit Grades Menu for each student and look at the Vocabulocity statistics near the bottom 
of the menu. 
 
Disable Spelling Bee* - (Option only appears if Spelling Bee is installed; see Installation 
chapter.)  The Spelling Bee game is a fun way for students to practice spelling their vocabulary 
words in all subjects (except Spanish)and their spelling words in Language Arts.  “Disable 
Spelling Bee” blocks students from playing the spelling game. 
 
Disable Alpha 14* - Alpha 14 is the sequel vocabulary game to the original Vocabulocity.  
Select “Disable Alpha 14” to remove Alpha 14 from the list of games that appears below each 
vocabulary (or spelling) list. 
 
Disable WWW Access* - Select the button to disable this student’s World-Wide Web links.  
The student will no longer be able to access the Internet through the WWW links or the UTIL 
button on the toolbar.  If you have a student who spends too much time surfing the Web, you 
can disable his access and then turn it back on when his lessons are finished. 
 
Disable Focus Learning* - Disabling Focus Learning means the student will not loop back to 
incorrect problems in the lesson, rather he will continue from one lesson to the next, no matter 
his score. 
 
Remove “Leave message for teacher; skip problem” button* - This “skip problem” function 
provides a way for students to break out of the mastery loop of Focus Learning.  If students 
can’t get an answer, they can click on the little notepad near the problem number to leave the 
teacher a message and skip the problem.  This sends the problem to the teacher for review.  
When this option is disabled, a student can no longer skip problems when leaving messages for 
the teacher. 
 
Open Page* - The Open Page option allows students to cycle through quizzes and tests: no 
grading is done until the student indicates he is finished.  Any unworked problems will be 
given a zero.  (Note:  Students may be able to figure out answers based on clues found in other 
questions.) 
 
Open Book* - The Open Book option is the same as “Open Page,” but also allows students to 
enter and exit the quiz or test at will until they indicate they are finished.  (Note:  Students will 
be able to go back to the lessons to find answers.) 
 
Easy Spelling* - The spelling penalty, set in Grade Calculations of School Setup, counts a 
misspelled answer as correct, but takes points off for poor spelling.  This spelling penalty 
works only for larger words, while shorter misspelled words are counted as completely wrong.  
However, when you select Easy Spelling, shorter misspelled words will also be marked correct 
(with points taken off for poor spelling).  An even greater amount of spelling variations will be 
recognized and accepted in the larger words (i.e., when easy spelling is checked, students will 
get fewer fill-in-the-blank problems graded as “0” because of poor spelling.) 
 
Show Answer* - This option, when selected, shows students the correct answer after an 
incorrect response has been given.  (Students will still loop around in Focus Learning mode 
until they have entered in all answers correctly themselves.) 
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Note:  Some students may be tempted to loop through the lessons, looking at the answers 
instead of taking the time to work out the answers themselves. 
 
Disable “Past Due” Notice* - This option allows the use of lesson plans without posting “Past 
Due” warnings to students when they fall behind.  You may want to use this feature if you have 
manually edited the lesson plan so that it is different from the lesson plan the program is 
following. (Note:  If you need to adjust the lesson plan, you can change the calendar and create 
a new lesson plan based on the changes.  See Lesson Plans.) 
 
No animate* - This option turns off the cycling animation in the icons and bars within the 
lessons. 
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CHAPTER 12 
 
GRADING 
 
Apostolic Bible Curriculum comes complete with a grading system that grades objective 
answers and automatically records the scores.  Students know right away how well they are 
doing, and the teacher’s grading workload is drastically reduced.   
 
GRADE CALCULATIONS* 
 
You can change the default settings for the letter grade requirements, grade weighting, and 
more in School Setup.  The program will automatically do the math for you and keep track of 
the scores. 
 
To customize the grading scale*: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Customize the following: 

 
Letter Grade Calculation – Change letter grade requirements by typing the percent 
required next to the letter grade.  Default mode automatically sets the grades at 92%=A, 
84%=B, 72%=C, 64%=D. 
 
Spelling Penalty – The teacher can set the percentage that will be taken off the 
students’ scores for misspelled words.  Default mode is set to 15%.  However, this 
penalty does not apply to every word since, in some units such as in Language Arts, the 
curriculum requires exact spelling and punctuation.  To require exact spelling in all text, 
set spelling penalty to 100%. 
 
Note:  The spell check allows for certain phonetic combinations.  Spelling errors 
outside these parameters will be marked incorrect.  Default settings apply only to words 
of seven characters or more.  To change the spelling setting to include shorter words, go 
to Student Setup and select “Easy spelling.” 
 
Relative Score Weighting for Lessons – Set the Relative Score Weighting for Lessons 
to determine the weighting of the students’ total grades.  In default mode the lesson 
exercises are 5, projects are 20, quizzes are 25, and tests are 50. 
 
To change the weighting, type in ratio.  For example, the default settings are based on 
total “points” of 100.  You could set the equivalent weight by assigning 1, 4, 5, and 10, 
for a total of 20. 
 
Note:  The weighting is based on percentages rather than total marks. 
 
Grade Display – Set the grade display to letter grades and/or percentage grades to 
determine how the grades will be shown in student and teacher menus as well as printed 
grades. 
 

Reset to Default State* 
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To reset School Setup back to the original default settings: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup; scroll down to the bottom. 
3. Click on Reset School Setup to Default State. 

 
AUTOMATIC GRADING 
 
As soon as students click on NEXT (F2) while working in a lesson, the computer grades the 
answer.  If the student answered correctly, the program automatically advances to the next 
problem.  If the student answered incorrectly, the program leaves the incorrect answer on the 
screen for the student to review.  The student must then manually advance to the next problem 
or presentation by clicking NEXT (F2). 
 

Teacher Tip*:  If you disagree with a problem grade, you can go into the lesson and 
change the score.  For example, the student might spell a word in such a way that the 
program does not recognize it as being the correct answer.  You can override the 
computer and give partial or full credit (See Entering/Changing Grades). 

 
Teacher Grading* 
 
You will want to follow behind the student to grade essays and paragraphs and read any 
messages he or she has left for you.  You will know there is grading to be done when the 
“Needs Grading” notice appears on the student subject icons.  Click on that notice to go 
directly to the problems needing attention. 
 
Note:  Only completed lessons will display the “Needs Grading” notice. 
 
Teacher Tip:  Even if there is no “Needs Grading” notice, look through the lessons, paying 
particular attention to the problems the student got wrong.  These will be colored red so you 
can quickly spot them. 
 
“Needs Grading” 
 

1. Click on Go to Teacher Mode. 
2. Click on student’s name. 
3. Look for a “Needs Grading” notice on the subject icons. 
4. Click on the icon to shortcut to the problem, or answer a student’s question about it. 

 
To grade, compare the student’s answer with the suggested answer or marking 
guidelines located within or below the problem.  Type the grade in the score box or a 
type a “space” (press the space bar) to clear the score and send the problem back to the 
student for rework (see Entering/Changing Grades). 
 
To respond to a student’s question, click on the flapping “message” notebook icon near 
the score box.  Type in your response and click Save.  Then “clear” the score box (click 
in the box and press the space bar) to send the problem back to the student for rework. 
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If a computer-graded problem was sent to you without a student message, the student 
likely skipped the problem without leaving a message.  You can leave your own 
message, then clear the score box to send the problem back to the student. 

 
5. To go to the next problem needing grading, you can click on NEXT on the toolbar (or 

press F2 or do a right-click).  Clicking on DONE or pressing the Esc key ends the 
grading session. 

 
ENTERING/CHANGING GRADES* 
 
To enter or change a grade on a problem, simply click in the score box and type one of the 
following: 

• Type a letter grade: A, B, C, D, P (for Pass, which is the same as A), F or X (X is the 
same as F); the percentage will automatically be calculated as the highest percent in the 
grade range for that letter grade.  (See grading scale in School Setup.) 

• Type in a number from 0 to 100 percent and the letter grade will automatically be 
calculated based on the grade scale used in School Setup. 

• Type a fraction:  the percentage will automatically be calculated and a letter grade 
assigned.  Examples: 7/8 or 17/19. 

• Type “s” to skip or unassign a problem.  A problem can be skipped in advance of, 
during, or following a student’s work session in that lesson. 

• Type a space (press the space bar) to clear out the problem score and send the problem 
back to the student to rework. 

• Type “g” to set the problem score to “Gave Up” Students can give up on a problem 
(using Problem Helps) to stop the problem from being repeated in Focus Learning 
mode.  “Gave Up” is scored the same as a zero (0). 

• Clear (erase) a report by holding the Shift key and clicking on the Report icon. 
 
CHECKING STUDENT WORK 
 
To review (and preview) student work, go into the Unit Grades Menu to see the table of 
contents.  From here, you can access each assignment, see the student’s answers, and the 
answer key.  This is the same location where you can assign, skip, clear, or block assignments 
as well (See Customize the Curriculum). 
 

1. Click on Go to Teacher Mode. 
2. Click on student’s name. 
3. Click on a subject/unit button located under the Overview title (see graphic below). 
4. Click on a lesson title to go into the curriculum to preview, review, or grade.  You can 

quickly scan for student errors by looking for problems colored in red. 
5. Assignment problems will be highlighted in one of three colors: gray, red or black. 

 
Gray = “skipped” by either the student or the teacher. 
Black = the student has answered the problem 100% correctly or has done no work at 
all in that lesson. 
Red = the student got less than 100% on the question, gave up, or has started work in 
the lesson but is not completely finished yet. 
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Teacher Tip*:  Because the program treats a multiple-answer response inside a 
single text box as one answer, you may want to consider overriding the grade 
generated by the program.  For example looking at a punctuation problem in 
Language Arts, a five-answer response within a single textbox would receive a 
zero if any one of the five answers were wrong.  You would want to manually 
change that grade to an 80% if the answers were to be equally weighted. 

 
Clear Entire Lesson or Single Problems* 
 
The teacher can delete all student work in a lesson and send the lesson back to the student to 
rework.  Click on Clear to bring up the prompt “Delete Student Work and Grades?”  Select 
YES. 
 
Teachers can also clear a single problem to send back to the student.  Simply type a space in the 
problem score box to clear the grade. 
 
ANSWER KEY 
 
Teachers can access the answer key at any time (both in Teacher Mode and in Student Mode, 
using a password).  Students, however, must first complete the assignment before they can see 
the answer key. 
 
To see the answer key: 
 
In Teacher Mode or in Student Review: 

• Open the assignment in Teacher Mode (or in Student Mode, Review Menu after the 
student has completed the assignment.) 

• To see the computer-graded answers, hold down KEY on the toolbar, or hold down the 
Shift key on the keyboard; release to go back to the student answer.  You will toggle 
between the answer and student answers. 

• To “lock” the answer key on the screen, press the F5 button; press again to return to 
student answers. 

• The answer key for paragraph-type problems is displayed below the paragraph box. The 
answer key for Projects follows the project instructions. 

 
In Student Mode (Problem Helps): 
 
While a student is working in an assignment, the teacher can use a password to access the 
answer key for a given problem.  Note:  You must have a Teacher Password already set up. 
 

1. Click on UTIL on the toolbar to open the Utility Functions box. 
2. Under Problem Helps, choose either Give up (gives a score of 0), Skip (passes over the 

problem), or Answers (displays the answer key). 
3. Enter you teacher password and click OK.  The answer key will display.  Click 

anywhere with the mouse and the answers will disappear. 
 
Reading the Answer Key 
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If a problem allows text box will contain an ellipsis (…), and the alternate answers will be 
displayed at the bottom of the question, correct answer groups separated by commas.  Square 
brackets [] around letters indicate optional text.  Curly braces {} indicate a key word in the 
answer.  Generally only the primary answer is displayed in a text box; however, alternates are 
often allowed. 
 
Grading Projects* 
 
Students are assigned projects periodically as they progress through their subjects.  Encourage 
your students to complete these projects as assigned rather than let the projects build up.  When 
a project has been assigned the Grading Menu will list it by subject name, number, and title.  
For example, Essay l505B-Making Conversation is an essay called “Making conversation” 
assigned from 5th grade Language Arts, unit 5, the second essay. The “B” indicates it is the 
second essay in the unit.  If no projects have been assigned the screen will say indicate “No 
projects are being worked on.” 
 
When a project is completed, the student clicks on a button to send the project to you to grade.  
Then, once you have graded past the point in the lesson plan where the project was assigned, a 
Project icon will appear on the Grading Menu below the subject icons.  Click on the project to 
open and grade it.  Any grading guidelines will be located near the bottom of the page.  Click 
on the “Report” icon to see the student’s work.  When you are grading, you can type you 
comments in a different color (change the font size and color – Format | Font) and save the 
changes. 
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CHAPTER 13 
 
CUSTOMIZING THE CURRICULUM* 
 
You can customize the Apostolic Bible Curriculum to better meet the needs of your students.  
You can: 
 

• Assign/Skip/Block assignments 
• Add your own Special Project 
• Customize a subject by combining grade levels, and/or subjects. 

 
ASSIGN/SKIP/BLOCK ASSIGNMENTS* 
 
If you need to add or take away from the workload or select alternate assignments for your 
student, you can do so easily. 
 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Click on the subject/unit button located under Overview to view the subject/unit table of 

contents (Unit Grades menu). 
4. Click on a title to open the assignment and look it over (Click DONE to return to the 

Unit Grades menu.) 
5. Click the “Assigned” or “Skipped” button to change it to one of the following: 

 
Assigned = work is sent to student to complete  
 
Skipped = student never sees work; not included in grade 
 
Blocked = work assigned, but the student cannot continue until the teacher changes the 
setting to “Assigned.” Note: “Allow Lesson Blocking” needs to be enabled in School 
Setup before the “Blocked” option will appear.  Go to School Setup and under 
“Installation and Defaults” select Allow Lesson Blocking. 
 

Teacher Tip:  If you “Block” the quizzes and tests, your students will need to 
tell you when they are ready for those assignments.  You can then ensure all 
student work is graded before assigning the quiz. 

 
Add your own Special Project* 
 
You can add your own assignments to Apostolic Bible Curriculum.  Every unit has an 
assignment called “Special Project.”  This project template provides space for you to add your 
own assignment, field trip, book report, essay, etc.  When assigned, the Special Project is 
included in the overall project grade for that unit. 
 
To add your own Special Project: 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name. 
3. Choose the unit from the subject/unit buttons in the Overview section of the menu to go 

to the Unit Grades Menu. 
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4. Scroll down to the bottom of the assignment to where you see the title bar for Special 
Project.  Click on the “Skipped” button until it says “Assigned.” 

5. Click on the title “Special Project” to open the project. 
 
Click on the notebook icon near the score box.  Type your instructions here and click Save. 
 
CUSTOMIZE A SUBJECT* 
 
Using the Custom Subject feature, you can reorganize the curriculum in a variety of ways.  For 
example: 

• Rearrange units within a given subject to present the material in a different order. 
• Combine grade levels to provide extra review or additional challenge, all within the 

same year-long lesson plan. 
• Create true “semester” classes out of five-unit electives by combining two semester-

length courses.   
 
A custom subject can be created in School Setup for all students to use or in Student Setup for 
an individual student’s use.  You may wish to refer to the Scope and Sequence (there is a link 
on the Teacher Menu) to help you make decisions on which units to include.  A customized 
subject can have up to 20 units. 
 
Create Custom Subject* 
 
To create a custom subject for ALL students to use (School Setup): 
 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Click on Create Custom Subject. 
4. Invent a new name for your custom subject and enter it next to New Subject Name. 

 
As the graphic shows the numbered columns represent the unit numbers for the source subjects.  
Type numbers in the grid to indicate the order in which you want the units to be assigned.  For 
example, if you want the first unit of you custom subject to be taken from Language 8, unit 5, 
enter a “1” in that box, and so on.  Note:  Stat with “1,” number the units consecutively, and do 
not repeat numbers. 
 
Go to the student’s Student Setup to assign the custom subject. 
 
To create a custom subject for an individual student (Student Setup):* 
 

1. Click on Go to Teacher Mode. 
2. Click on student’s name. 
3. Click on Student Setup. 
4. Click on Create Custom Subject for Student. 
5. Invent a name for your custom subject and enter it next to “New Subject Name.” 
6. The numbered columns represent the unit numbers for the source subjects.  Type 

numbers in the grid to indicate the order in which you want the units to be assigned.  
For example, if you want the first unit of your custom subject to be taken from 
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Language 8, unit 5, find the row for Language 8, go to column 5, and enter a “1” in that 
box.  Note:  Stat with “1,” number the units consecutively, and do not repeat numbers. 

7. Assign the custom subject. 
 
Note:  When you create a custom subject, you are making a “shortcut” to the source subjects.  
In the SOS messaging system and Unit Grades/Review menus, the subject title will not be the 
custom subject name you made up (e.g., “My Language”); rather, it will be the name of the 
source subject.  However, the custom subject name will appear on the subject icon bar and in 
the list of available subjects in Student Setup. 
 
Remove Custom Subjects* 
 
To remove school custom subjects: 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Under Installation and Defaults, click on Uninstall Subjects from School. 
4. Choose the subject(s) to uninstall and click DONE on the toolbar. 

 
To remove student custom subjects: 

1. Click on Go to Teacher Mode. 
2. Click on student’s name. 
3. Click on Student Setup. 
4. Click on Remove Custom Subjects for Student (button appears only when there is a 

custom subject). 
5. Select the subjects you want to remove. 
6. Click on DONE on the toolbar.  This deletes the custom subject, but student work can 

still be accessed through the source subject; i.e., if you assign the subject (on its own, 
not in a custom subject), work completed will appear. 

 
VIEW SCOPE AND SEQUENCE 
 
The Scope and Sequence displays a detailed list of subject unit and lesson titles available in 
Apostolic Bible Curriculum. 
 

1. Click on Go to Teacher Mode. 
2. Click on View Scope and Sequence to open the document in you word processor. 
3. Browse the document to see the detailed listing of all the available subjects. 
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CHAPTER 14 
 
MESSAGES 
 
Teachers and students can leave messages for one another using Apostolic Bible Curriculum’s 
internal message system. 
 
The program provides a general message box for each subject and a specific message box 
(called a “problem note”) for each problem. 
 
SUBJECT MESSAGES 
 
Open the message box – The subject message box opens when the teacher or student clicks on 
a subject icon.  Each subject has its own message box. 
 
You can also open the message box while you are in a lesson: 
 

1. Click on UTIL on the toolbar to open the Utility functions.  There is a button labeled 
“Messages for [Science].”  Click on the button to open the message box.  Or… 

2. Click on the Pause key on the toolbar to open directly to the message box. 
 
Leave a message – Type in the appropriate box (student or teacher); then, click on any 
message-window button or press the Esc key on the keyboard to save the message and go back 
to the previous menu. 
 
Erase a message – You must be in Teacher Mode to erase the teacher message, and in Student 
Mode to erase the student’s message.  Highlight the message and press the space bar or the 
Delete key on your keyboard.   
 
PROBLEM NOTES 
 
Open a problem note – Go into the lesson and scroll down to the problem.  (The Problem 
Notes are like “sticky notes” attached to specific problems.”  Click on the notebook icon to 
open a small message window. 
 
Leave a message – Both teachers and students can leave messages in the same Problem Note.  
Type the message then choose Save. 
 
Leave message; Skip problem – Students can also click on the option “Leave message for 
Teacher; Skip problem.”  If the student chooses skip, the problem will be sent to the teacher for 
review.  In this way, students can break out of the mastery loop in Focus Learning if they can’t 
get past a problem.  (This feature can be disabled in Student Setup by selecting the box labeled: 
“Remove Leave message for teacher; skip problem button.”) 
 
Alerts – The “Needs Grading” notice on the subject icon will alert the teacher to any skipped 
problems.  However, teachers will NOT be alerted to any messages left on problems that have a 
grade in the score box.  If students want teachers to see those messages, they will have to tell 
their teachers. 
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To alert students to a message, the teacher must “clear” the score box (click in score box and 
press space bar) to send the problem back to the student, allowing the student to rework the 
problem. 
 
When a Problem note is left by either teacher or student the notebook cover will flap up and 
down and flash the word “Message.” 
 
Erase a problem note – Open the note, then click the Erase button to delete the message.  Both 
teachers and students can erase any messages left in a Problem Note. 
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CHAPTER 15 
 
STUDENT RECORDS 
 
Apostolic Bible Curriculum automatically records student scores and keeps up-to-date records 
of grades and selected student activities.  These grades are displayed in both Teacher and 
Student Mode.  Teachers can print grade and score reports and keep a personal file on each 
student. 
 
GRADES 
 
As students answer problems, their work is graded and the scores recorded.  When a lesson is 
finished, the lesson score, unit score, and subject score are computed and displayed.  (Grades 
will not be displayed for an unfinished lesson.) 
 
The following program locations display grade information: 
 

• Grading/Schoolwork Menu – Subject and unit grades 
• Unit Grades/Review Menu – unit and individual assignment grades 
• Assignments – individual problem grades 

 
PRINTED REPORTS 
 
Print Grades 
 
The “Print Grades” button on the Grading menu prints off a pre-formatted, student-specific 
“report card” which lists subject-unit grades, semester grades, and final grades.  Grades for 
incomplete units are not displayed.  If you need a more detailed grade report, including 
incomplete units, see “Export Scores.” 
 
Export Scores 
 
Using the Export Scores feature, you can copy your student’s detailed grading information into 
a spreadsheet or word processor for organizing and printing. 
 
The “Export Scores” button on the Teacher menu saves a text file to a location you choose.  
Once the data has been exported, you can import the scores into a spreadsheet or word-
processing program where you can arrange it into tables.  The information is set up using tabs 
and includes the student names, lesson titles, and grades as follows: 
 
ID    Name    Subject    Unit    Type    Score    Lesson    # 
 

ID = Student number 
Name = Student name 
Subject = academic subject 
Unit = unit number  
Type = one of the following: L = Lesson, Q = Quiz, T = Test, P = Project, ! = Student 
(total score), U = Unit (for unit score), S = Subject (for subject score) 
Score = grade value 
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Lesson = lesson name and number 
# = number of activity (counts lessons, quizzes, tests, and projects). 

 
To export scores: 

1. Click on Go to Teacher Mode. 
2. Click on Export Scores. 
3. Choose the location where you want to export the scores to and select OK.  
4. Scores will be exported as a .txt file called “scores.txt.”  You can then bring the data 

into your own programs to organize how you like.  (See your word 
processor/spreadsheet manual to learn how to import text delimited with tabs.) 

 
For example: 
 
To convert the text into a table in Microsoft Word: 

1. Highlight the text. 
2. Pull down the Table menu. 
3. Select “Convert text to table.”  The number of columns will be tabulated for you.  You 

can change the size of the columns now or after the table has been made.  Make sure the 
separate text at” option is set to tabs. 

4. Click OK. 
 
Note:  This creates a large table that is better displayed as “landscape.”  To change the page 
layout to landscape, pull down the File menu, select Page Setup, select the Paper Size tab, and 
choose Landscape. 
 
CUSTOMIZED STUDENT RECORDS* 
 
Each student has an “Access Student Records” button on his or her Grading Menu.  Click here 
to open a word processor document in which you can record additional information about your 
student.  By default the link is made to the teacher’s word processor program.  Apostolic Bible 
Curriculum does not add information to this file so you can do with it what you wish.  Students 
do not have access to the Access Student Records button since it is included for administrative 
use only. 
 
Status 
 
The Unit Grades Menu shows the following information at the bottom of the page: 

• Time the student first began work in the unit 
• Time the student last worked in the unit 
• Total time spent in the unit 
• Times pent in the games Vocabulocity, Spelling Bee, and Alpha 14 (number of tries, 

number of wins)  Note:  This information appears only when the student has used these 
features. 
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CHAPTER 16 
 
PRINTING 
 
Apostolic Bible Curriculum provides a variety of printing options.  Teachers can print the 
curriculum, answer keys, various grade reports and other items. 
 
Print Lesson Plan 
 

1. Click on Go to Teacher Mode. 
2. Click on the student’s name to go to the Grading Menu. 
3. Click on the button View Lesson Plan.  (If there is no button, that means there is no 

lesson plan) The lesson plan displays in the teacher’s word processing program. 
4. To print from the word processor, select the “File” menu then “Print.” 

 
Print Entire Lesson or Text-Only 
 

1. Click on Go to Teacher Mode. 
2. Go to the assignment you want to print. 
3. Choose one of the following options: 

a. Hold down the CTRL key and press the P key, or  
b. Click on UTIL on the toolbar and choose Print (entire lesson) or Print Text (text 

only), or 
c. Hold down the CTRL key and press the C key to copy the text to the computer’s 

clipboard.  You can then paste this text into any word processor for printing.  
Once in a word processor, you can change the size of the font or edit the lesson 
to be printed. 

 
Print Answer Key 
 

1. Click on Go to Teacher Mode. 
2. Go to the assignment you want to print. 
3. Press F5 to lock the answer key open. 
4. Hold down the Ctrl key and press the P key, or Click on UTIL on the toolbar and 

choose from the printing options. 
 
Print Vocabulary and Spelling Word Lists 
 

1. Click on Go to Teacher Mode. 
2. Go to the assignment and scroll down to the word list you want to print. 
3. Scroll to the bottom of the list and click on the statement Click Here to Copy/Print List.  

Follow the on-screen instructions. 
 
Print Grades 
 

1. Click on Go to Teacher Mode. 
2. Click on student’s name. 
3. Click on the Print Grades button and click OK in the print menu which appears.  (This 

feature will print grades with semester grading). 
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Note:  You can also use the Export Scores feature to print a more detailed listing of grades.  
See the chapter on Student Records for how to create a detailed grade report for use in a 
spreadsheet or word processor. 
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CHAPTER 17 
 
TECHNICAL & TROUBLESHOOTING 
 
RECOMMENDED SYSTEM REQUIREMENTS 
 
CD-ROM Multimedia PC: 
Pentium 133 or better 
16 Megabytes of RAM or better 
160 Megabytes of hard drive space for full installation 
16-Bit sound card capable of 22,050 KHz or better 
SVGA Video Display Card capable of 640x480 by 256 colors 
4X CD-ROM drive or better 
Windows 95, 98, 2000, or ME (NOT Windows NT) 
 
INSTALLATION REQUIREMENTS 
 
Minimal installation requires 60 MB of hard drive space (does not include games, intro videos, 
or desktop themes). 
 
Small installation requires 90 MB of hard drive space (does not include intro videos or desktop 
themes). 
 
Full installation requires 160 MB of hard drive space.  (170 if Distance Learning) 
 
 
TOP EIGHT FAQ’S AS COMPILED BY TECH SUPPORT DURING 2001 
 
Error Message 
 
If you receive any kind of error message, shut down SOS and try restarting your computer. 
 
Frequent Errors/Lock-Ups 
 
Disable your anti-virus program, as it can cause conflicts with SOS. 
 
Can’t Find the Lesson Plan 
 
Go into Teacher Mode, click on your student, and click STUDENT SETUP.  Here you will find 
the CREATE LESSON PLAN along with many other valuable options. 
 
Display Problems-Alpha 14 
 
If the game is only playing on only half the screen, go to your START MENU, SETTINGS, 
and open the Control Panel, Double-click on DISPLAY.  Go to the SETTINGS tab and change 
the Screen Area to 800x600. 
 
Cannot View Lesson Plan/Open Project 
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You need to set up your word processor.  Go to TEACHER MODE and access SCHOOL 
SETUP.  Use the Locate Word Processor for teacher and student. 
 
Caught in Lesson Loop and Cannot Advance 
 
This is FOCUS LEARNING.  Focus Learning allows the student to earn 100% before 
continuing on to the next lesson.  Focus Learning can be disabled in STUDENT SETUP.  
Please consult your user manual for more detailed information on Focus Learning and its 
purpose. 
 
No New Games or Calendar 
 
If you have installed the new software but still cannot access any new games or the calendar, 
you may not have run a FULL install.  If this is the case, run INSTALL per the normal 
instructions and be sure to click FULL INSTALL 150MB on the first screen entitled INSTALL 
OPTIONS. 
 
Subjects Not Showing 
 
This is because you must still ASSIGN the subjects to your student.  This is done in TEACHER 
MODE by going to the student and opening STUDENT SETUP. 
 
FREQUENTLY ASKED QUESTIONS 
 
This section is divided into subtopics to help you find answers quickly.  The categories are:  
Technical, Multimedia, and General. 
 
Technical 
 

• Why does the data take up so much hard drive space? 
 

Your computer’s operating system contains a “clustering” mechanism that 
automatically designates a certain amount of space for each file, even if a file has very 
little data in it.  Each subject uses about 200 files.  If you right-click on one of these 
files and look at “Properties” (in Windows 95/98), you will be able to see the actual 
amount of data the file contains and the amount of space it is taking up on the hard drive 
because of the clustering.  The amount of space will be from four to sixteen megabytes 
per student per year (five subjects).  However, you should be able to copy that same 
data onto a single floppy. 

 
• How do I add another subject? 
 

1. Click on Go to Teacher Mode. 
2. Click on School Setup. 
3. Click on Add Subject and follow the on-screen instructions. 

 
Note:  Remember to assign the subject to your student in Student Setup. 

 
• How do I maintain back-ups of the students’ work? 
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Use the Back Up/Restore function to do this. (See Back-ups in Chapter 1.) 

 
• When attempting to restore from a back-up, why do I get an error, “Not enough 

RAM?” 
 

Unfortunately, this error means your back-up disk has gone bad.  Data is lost. 
 

• My student is going to be moving to another computer.  How do I transfer the 
grade files from my computer to the new one? 

 
Use the Back Up Data function (See Back-ups in Chapter 3) to obtain a back-up of your 
student data.  Install Apostolic Bible Curriculum onto the new computer.  Use the 
Restore Data function to restore the student’s work on the new computer. 

 
• My CD-ROM drive letter has changed and Apostolic Bible Curriculum isn’t 

working anymore.  How do I fix it? 
 

First, make a back-up of all the student grade files.  Then run the remove.bat program 
off any current SOS CD-ROM.  Answer “Y” to all questions.  Reinstall Apostolic Bible 
Curriculum and use the Restore Data function to restore you students’ data. 

 
Multimedia 
 

• How do I stop a video or sound link from playing? 
 

Click anywhere with the mouse button. 
 

• Aren’t there supposed to be videos that show the grade at the end of the lesson? 
 

These videos must be installed on your computer and “Letter Grades” must be selected 
in School Setup. 

 
• Why do the video clips run “choppy” or slowly sometimes? 

 
There may be many reasons for this: 

• Insufficient processor speed (slow computer) 
• Video card quality 
• Running multiple programs and using RAM elsewhere 
• CD drive is slow (less than 4X) 
• CD drive is having trouble reading the CD 
• In a networked situation, a slow network server 

 
• Why does nothing happen when I click on a blue word (sound link) or graphic 

with a video camera or speaker symbol? 
 

Sometimes the videos and sound links take a few moments to load.  If you click on the 
mouse button again while you are waiting for the multimedia to start, you stop the video 
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from playing.  Click once, then wait for the multimedia to play.  Also see “Why does 
the computer hang or crash on some videos?” below.  If the multimedia still will not 
play, contact Technical Support at 1-866-444-4498. 

 
• Why does the computer hang or crash on some videos? 

 
Reason 1:  Your anti-virus software may be causing problems.  Disable your anti-virus 
software may be causing problems.  Disable your anti-virus program and shut down all 
other running programs. 

 
Reason 2:  This may be also a problem for some Windows 95 users due to a problem 
with video compression. 
 
First, lower the Graphics Accelerator: 
 

1. Click “Start” button in lower left corner of the computer screen. 
2. Go to “Settings.” 
3. Left-click on “Control Panel.” 
4. Double left-click on “System” icon. 
5. Left-click on “Perform” tab. 
6. Go to “Advanced Settings” and left-click on “Graphics” button. 
7. In “Advanced Settings” box, if hardware acceleration is full, move tab back two 

notches. 
8. Click “Ok” button in the “System Properties” box. 

 
Or, try reinstalling the multimedia from your Windows 95/98 installation disks.  To do 
this you will need to uninstall all your multimedia using “add-remove” programs in 
your control panel: 

1. Open Control Panel.  Double-click on Add/Remove Programs, choose the 
Windows Setup tab. 

2. Scroll down to Multimedia and uncheck it.  When you close these windows, 
your multimedia will be disabled. 

3. You must now insert your Windows CD.  Go back through these steps and 
recheck Multimedia to reinstall it.  

4. Restart the computer. 
 

• What is the difference between the “A” disk and the “B” (or “C”) disks? 
 

The “A” disk contains the installation program and the first few units of the subject.  
“B” and “C” disks contain the later units of the subject.  Apostolic Bible Curriculum 
will prompt you as to which disk you need to have in the CD drive.  Always use the “A” 
disk to install the program or to install the subject. 

 
• How do I print the curriculum? 

 
You can print only while you are in Teacher Mode.  Simply hold down the CTRL key 
and press the P key or click on UTIL on the toolbar.  Select Print or Print Text. 

 
• Do I have to listen to the introduction every time I begin the program? 
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No.  Click the mouse button at any time during the opening animation to stop the 
introduction. 

 
• Why aren’t there any subject bars (icons) displayed in the Schoolwork Menu? 

 
Check the settings in Student Setup (found on the Grading Menu).  Subjects must be 
assigned for the icon to appear on the student’s Schoolwork Menu. 

 
• Why is an answer marked correct when it is different from the answer key? 

 
The answer key shows the most common or expected answer.  Other possible answer 
have been scripted into the answer key but are not displayed. 

 
• Why is an answer marked wrong when it is the same as the answer key? 

 
The answer is not the same as the answer key.  This confusion may occur with certain 
types of questions.  Some questions already have text in the answer boxes and students 
are required to add punctuation, change spelling, or some other such activity.  The 
grading system in these cases is very exact.  If there are extra punctuation marks or the 
capitalization is different, the answer will be graded as “Incorrect.” 

 
• Why do the reports come up empty when I click on them to grade? 

 
Your student changed the name of the report file (i.e., chose “Save As” then changed 
the file name).  Apostolic Bible Curriculum links to the original file name.  Have your 
student find that file (through your word processor), make a copy of the text and paste it 
back in the Report, click on Save. 

 
• How does the student get past a problem that keeps coming back (when Focus 

Learning is selected)? 
 

The student can give up on the problem by clicking on UTIL on the toolbar.  A dialog 
box will open, giving the student Problem Helps.  To skip or give up on the problem, 
the teacher must type in the password (set in School Setup). 
 
Another way to skip a problem is through the Problem Notebook.  Click on the small 
notebook near the problem number and choose the “Leave message for teacher; skip 
problem” option.  Note:  This option can be disabled in Student Setup. 

 
• Why does nothing happen when I click on the World-Wide Web links in the 

curriculum? 
 

1. You must have your own Internet connection from a service provider for the 
links to work.  Apostolic Bible Curriculum has links set up to the Web but is not 
a service provider. 

2. There might be something wrong with the location of your web browser.  
Apostolic Bible Curriculum does not include a web browser. 
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• How do I delete a student? 
 

In Teacher Mode, hold down the Shift key and click on the student’s name or go to 
Student Setup and click on Delete This Student. 

 
• I forgot my Teacher Password.  Is there a way to find out what it was? 

 
Hold down the shift key and click on the “Go To Teacher Mode” icon.  This will erase 
the teacher’s password. 

 
• When do the Past Due notices get updated? 

 
The project icon will not appear in the teacher’s Grading Menu until the teacher has 
graded past the lesson preceding the project assignment. 

 
• How do I uninstall the program? 

 
Run the install.exe program off any current SOS CD-ROM.  Select uninstall. 

 
TROUBLESHOOTING 
 

• Windows Help Menu 
 

The Windows 95/98 Help menu is a useful tool to help you correct problems associated 
with the computer, rather than with the program.  Under the Start menu, select Help, 
then click on the Contents tab.  Double-click on Troubleshooting.  If your question is 
not listed, click on the Index tab and type in a keyword.  You can also get online help at 
www.Microsoft.com. 

 
• I have problems installing the program. 

 
Check to see if you have enough hard drive space.  See System Recommendations. 

 
• I installed the subject but my student can’t access it. 

 
You must assign the subject to each student in the Student Setup on the Grading menu. 

 
• When I scroll down the page, the writing gets all jumbled and mixed around. 

 
Try exiting other programs that may be running at the same time, or reducing your 
screen size, or increasing the amount of your computer’s hardware RAM. 

 
• I can’t scroll to the right. 

 
You will need to turn off Autohide on your taskbar. 
 

1. Right-click on the taskbar. 
2. Select Properties. 
3. Deselect Autohide. 

http://www.microsoft.com/
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• The program randomly freezes.  

 
1. Disable your anti-virus program. 
2. Try running Scandisk on the hard drive (Start | Programs | Accessories | System 

Tools).  If you still have a problem, try running Disk Defragmenter.  Still 
problems?  Turn the Hardware Acceleration down to none (right-click on My 
Computer | left-click on Properties | click on the Performance tab | click on the 
Graphics button | turn the Hardware Acceleration down to none.) 

 
• I’m getting general protection faults and the program crashes when the screen 

saver comes on. 
 

1. Disable your anti-virus program. 
2. Exit all other programs and turn off the screen saver. 

 
• I’ve set up the lesson plans, but the due dates and Past Due notices are wrong. 

 
Check the calendar setting on your computer.  Make sure that your computer is set to 
the current date. (For Windows 95, go to Start Menu | Settings | Control Panel.  Double-
click on Date/Time.  Make necessary changes. 

 
• I changed my lesson plan and now the due dates are wrong. 

 
Create a new lesson plan and make sure you select the button at the top of the calendar 
labeled “Continue from now.”  If the dates are still wrong, go back into the calendar and 
deselect the days that have already gone by. 

 
• I have problems printing the lessons. 

 
Try printing again, and when the main print screen comes up: 
 

1. Change the DPI setting to the lowest possible. 
2. Change your color printer setting to black and white, grayscale, or monochrome. 
3. If you have a print quality button, set it on Draft, or the lowest possible. 
4. If you have a button for graphics, set it on Coarse. 

 
If the above did not work, load (from you Windows 95 or 98 CD) a lower-level driver 
than what your printer is.  For example, if you have an HP Deskjet 560, select the driver 
for the HP Deskjet 320. To load a new driver: 
 

1. Insert your Windows CD and click on Start. 
2. Go to Settings | Printer | Add Printer and click NEXT. 
3. Choose Local Printer and click NEXT. 
4. Find your printer, select the lower-level driver, and click NEXT. 
5. Choose LPT1 (or whatever port your printer is on and click NEXT.) 
6. You do not want to use the new drivers as the default drivers.  Click NEXT. 
7. You do not need to print a test page. Click NEXT. 
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8. When the drivers are installed, go back to SOS and try printing again.  At the 
main print screen, click on Setup, then on Specific Printer. 

9. Select the printer you just installed and click Print. 
 

• My student cannot go past a quiz or test. 
 

A quiz or test could lock up the program if there has been a combination of Open Book 
testing with regular testing.  For example:  The student started to take a quiz or test in 
Open Book mode but left the test unfinished.  The teacher, meanwhile, cancelled the 
Open Book test (deselected it in Student Setup).  The student will not be able to go back 
into the test or go past the test.  To correct, the teacher can either clear the test for the 
student to redo, or select Open Book again and allow the student to go back in and 
finish the test. 

 
ERROR MESSAGES 
 

• Dek error. 
 

1. First, shut down SOS and restart your computer.  If this doesn’t work, go on to 
Step 2. 

2. Right-click on your SOS icon on your desktop.  Go to Properties, then Shortcut. 
3. Make sure the line labeled “Target” says: C:\SOS\SOS.EXE (or whatever your 

drive is). 
 
If this is not the problem, then you will need to uninstall and reinstall the program. 
 

1. Make a back-up of all the student grade files. 
2. Run the install.exe program off any current SOS CD-ROM. Select uninstall. 
3. Reinstall Apostolic Bible Curriculum and use the Restore Data function to 

restore you students’ data. 
 

• Cannot Load Lesson Counts (when trying to generate a lesson plan). 
 

1. Double-click on My Computer | Double-click on you C:\ drive | Double-click on 
the SOS folder | Double-click on the Work folder. 

2. Inside the Work folder, delete the folder called List. 
3. Immediately run SOS.  Clear the Calendar, reset it, then generate the lesson 

plan. 
4. Insert CDs if required. 

 
• Work on Grade File Altered 

 
1. Click on Go to Teacher Mode. 
2. Back up student’s work. 
3. Click on the student’s name. 
4. Under the Overview section on this screen, choose the subject/unit that the 

student is working in. 
5. Clear the last completed lesson.  Do this in all subjects that are giving this 

message. 
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• No Body 

 
Defective CD-ROM 

 
• Bad Sprite (Same as No Body) 

 
If you have received a BAD SPRITE error, this can be resolved by having the CD 
replaced.   

 
• This file is not a valid WIN32 application. 

 
1. Clean the CD carefully with a soft, clean cloth. 
2. Clean your CD drive.  (You can buy an inexpensive CD cleaner at most 

computer stores.) 
3. If Steps 1 and 2 are ineffective, the CD may be defective.  If you purchased this 

CD directly from Alpha Omega Publications, call us for a replacement. 
 

• Cannot Open for Reading/Writing 
 
Try each of the following: 
 

1. Verify you have enough hard drive space. 
2. If you have restored work from back-ups done on a CD-ROM be sure to turn the 

“read only” attribute off for all files contained in the C:\SOS folder. 
3. Make a proper floppy disk back-up, then completely delete the SOS folder.  

Reinstall. 
 

• Your Sound Card Is Not Working 
 

Restart your computer and run the program again.  If there is still a problem: 
 

1. Go to Start | Settings | Control Panel | Sounds. 
2. In the box labeled Schemes, select Windows Default None. 
3. Click OK. 
4. Restart your computer and try again. 

 
• Not Enough RAM (while trying to Restore Data) 

 
One of the files is probably too large to fit onto a floppy disk.  Try running the back-up 
to a hard drive or looking for a huge file in your student data (C:\SOS\WORK). 

 
• General Protection Fault/Illegal Operation (when trying to access or grade a 

lesson) 
 

1. First, disable your anti-virus program.  If this is ineffective, proceed to Step 2. 
2. Click on Go to Teacher Mode. 
3. Back up student’s work. 
4. Click on the student’s name. 
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5. Under the Overview section on this screen, choose the subject/unit that the 
student is working in. 

6. Clear the last completed lesson.  Do this in all subjects that are giving this 
message. 

 
 
 

*Locked in Distance Learning 
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